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Chapter 1: Introduction 
 
1.1 What is ClearStream RFID  

ClearStream RFID is the only user-configurable, fixed RFID tag and BLE Beacon reading software that gives you 
the flexibility to easily capture and stream data based on your specific business needs. ClearStream RFID can be 
used as an extension of your software management systems, streaming the data you need between readers and 
target databases. ClearStream RFID can also be used as a standalone system streaming to Excel, Access, SQL 
Server, ODBC databases and many other custom destinations.  
 
With the release of ClearStream RFID 8.0 users can now use ClearStream as the engine of a Real-time Location 
System (RTLS). With a valid subscription to the PTS RTLS Cloud users can gain unmatched visibility into critical 
business assets and their real-time locations. This service allows a user to upload and design maps and 
floorplans, place fixed RFID readers, and define custom zones, all through an easy to use drag and drop cloud 
environment. As the system is running the location of tagged assets will be displayed within the live map view of 
the user’s environment. The location data collected within the PTS RTLS Cloud can be integrated with many 3rd 
Party systems using a modern REST web service API. For more information on this service, visit the ClearStream 
RFID website. 
 
ClearStream RFID and the PTS RTLS Cloud are provided on a trial basis in order to offer businesses the 
opportunity to gain hands-on experience with the features of ClearStream RFID before buying. ClearStream 
RFID trial limitations such as a nag dialogue are removed after purchase and registration or subscription.  
 
1.2 How ClearStream RFID Works 

Tapping the power of ClearStream RFID through the creation of read processes allows users to see anything, 
anywhere, anytime with accuracy never seen before. Processes are unique tasks defined within ClearStream 
RFID that allow you to track your data through the use of RFID and Bluetooth Beacon technology. Processes, 
such as scheduling a reader to scan a room every twenty minutes, can be quickly configured by non-
programmers through the intuitive tools within ClearStream RFID. Below is a small sample of the processes that 
can be quickly configured via ClearStream RFID.  
 

Sample ClearStream RFID Application Configurations 
 

• Inventory Audits 
• IT Asset Tracking 
• Employee/Student/Visitor Tracking 
• Material Check-In/Check-Out 
• Loss Prevention 
• Vendor Managed Inventory 

 
1.3 ClearStream RFID Support 

As a registered ClearStream RFID user, you receive one free year of support which includes unlimited phone 
support, email support and free version upgrades. We encourage all users of ClearStream RFID to visit our 
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Support Center at https://www.clearstreamrfid.com/support for access to general Knowledgebase, frequently 
asked questions, training videos and other resources intended to speed the learning curve.  
 
1.4 A Note on Terminology 

With the latest release of ClearStream RFID, we have added support for some similar but slightly different 
technology, namely Bluetooth Beacons.  While the technology is similar enough, there are some differences.  In 
the interest of brevity for this document, we will use the term “tags” to represent traditional UHF EPC tags as 
well as the Beacon devices now supported in ClearStream RFID.  Similarly, we will use the term “readers” to 
represent both the traditional RFID readers as well as the Beacon gateways.  We will distinguish between the 
two technologies as appropriate but most of this documentation and descriptions serves to represent both. 

https://www.clearstreamrfid.com/support
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Chapter 2: Installation 
 
2.1 System Requirements 

• A Windows PC running Windows Vista/7/8/10/11, Windows Server 2008/2012/2016/2019. 
• Microsoft .NET Framework 4.8 or greater (You will be prompted for install if required). 
• Compatible RFID Readers: Zebra/Zebra IOTC, Feig, Impinj, Alien, Intermec, ThingMagic, Jadak or any 

other reader that supports LLRP (Low Level Reader Protocol). 
• Compatible RFID readers for ClearStream On-Board: Zebra FX7500, FX9600, ATR7000, and Impinj 

R700/720. 
• Compatible Bluetooth Beacon Gateways: BluEpyc, BlueCats, and Minew. 
• Network access or router connected to a standalone PC. 

 
2.2 ClearStream RFID Hardware and Software Installation 

ClearStream RFID enables readers to stream data to pre-existing databases across a network. Network access or 
a router connected to a PC is a preliminary requirement when using ClearStream RFID. With network access or a 
working router, follow the steps below to install readers, antennas and the ClearStream RFID software. 
2.2.1  Hardware Installation  

1. Mount RFID readers and antennas or Bluetooth Beacon Gateways as needed for configuration. 
2. Connect antennas to the antenna inputs of the reader using the supplied cables if required.  
3. Connect the RFID reader or Beacon Gateway to your network or a router connected to a standalone PC. 
4. Connect the power supply and line cord to the reader, then to a power source. 

2.2.2  Software Installation - ClearStream RFID Management Studio 

1. Download ClearStream RFID from https://www.clearstreamrfid.com/ or an authorized reseller and 
install to a PC that will be used to set up and administer the application. 

2. When the Install Wizard Completed screen appears you have the option to Launch Management Studio 
upon clicking Finish. 

3. Proceed to Chapter 3: Registration for registration and trial instructions. 
 

2.2.3  Software Installation - ClearStream Onboard 

ClearStream Onboard is another option for using ClearStream technology but in a more direct to the reader 
approach.  Specifically, ClearStream Onboard is available to run directly on select readers and can be useful in 
no/low network connectivity environments since tag data and even GPO feedback is all available without any 
outside control required.  Currently, this portfolio of readers supports Zebra and Impinj RFID readers but is 
always growing.  Installation instructions for ClearStream Onboard are included with this installation and can be 
found at “Windows Start menuPTSClearStream RFIDInstall Clearstream RFID Onboard.” 
 

https://www.clearstreamrfid.com/
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2.3   Uninstalling ClearStream RFID 

In the unlikely event that you would like to remove ClearStream RFID, follow these simple instructions.  
 

ClearStream RFID Windows Installation 
 

1. Exit ClearStream RFID if open and stop the ClearStream Service if running. 
2. Open the Control Panel window on your PC. 
3.  Select Add/Remove Programs or Uninstall or Change a Program (depending on OS). 
4. Locate ClearStream RFID and select Uninstall. 

 
ClearStream RFID On-board 
 

• Using a web browser, navigate to the RFID Reader’s web console administration tool. This is usually 
done by entering the IP address of the reader in the web browser. 

• Login to the web portal using the Reader login credentials. 
• Depending on the reader type the next steps will vary: 

 
Zebra Devices 
• Navigate to Applications using the main menu on left-hand side. 
• Select the CSOnboard application from the List of Installed apps drop down. 
• Stop the Application using the Start/Stop button. 
• Click on the Uninstall button to perform the uninstallation. 

 
Impinj R700/720 
• Perform a factory reset. 
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Chapter 3: Registration and Subscription 
ClearStream RFID offers flexible licensing options for any installation need. Licenses can be purchased as 
perpetual registrations (using a one-time code), or as a Subscription offering low recuring payment plans. The 
Subscription model also offers the benefit of a web portal to track devices’ status remotely, as well as access to 
the ClearStream RTLS Cloud. Chapter 3 describes these options in detail. 
 
3.1 ClearStream RFID Trial Limitations 

ClearStream RFID is available as a trial application. This trial mode allows potential users to test the functionality 
of the software without purchasing. Trial limitations include: 
 

• A trial code is required to stream data from your connected reader.  Follow the instructions below to 
request a trial code: 

o Select the Registration/Subscription… option from the Tools menu.  
o Click the Request trial code link from the Trial Info tab and fill out the web form.  
o Submit the form and a trial registration code will be emailed to the address provided. 

• A 30-day window to evaluate ClearStream RFID (Extensions are available). 
• The Windows Service will not run in trial mode; the Management Studio must be used. 

 
3.2 ClearStream RFID Licensing Model 

ClearStream RFID is licensed/subscribed per seat; a seat is the connection between the RFID reader or 
Bluetooth Gateway and the host PC in which ClearStream RFID is installed. Below is a typical ClearStream RFID 
install with licensing requirements.   

 
Example: Three registered or subscribed seats of ClearStream RFID enables three RFID readers to 
stream data to a host PC or server.  
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3.3 ClearStream RFID Subscriptions (Recommended) 

ClearStream RFID offers flexible licensing to suit your requirements. The Subscription model allows an 
administrator to pay for each seat on a schedule and manage these users in the ClearStream web portal. After 
purchasing a ClearStream subscription, use the Tools->Registration/Subscription dialog to enter your 
Username and Password you have configured in the web portal. The issuing of subscription seats can be done 
by using the web portal or allowing a device to connect and be automatically assigned when first starting the 
device. All Subscribed seats will be automatically downloaded from the web portal if the administrator were to 
install a new instance of ClearStream RFID. 
 
3.4 Registering ClearStream RFID (Perpetual)  

When utilizing a perpetual license of ClearStream RFID, the application must be fully registered. Registering 
ClearStream RFID is a simple process which can be completed after the purchase of seats. Registering the 
ClearStream software is done if a perpetual license was purchased. This is a one-time process unless additional 
seats are added at a later date. 
 

1. Purchase a ClearStream RFID license for the number of seats / readers you need to enable. 
2. After purchase, you will receive a confirmation email including a Redemption Link; this link will enable 

you to register the number of seats you purchased.  
3. Click the Redemption Link which will open a Registration Request form. Complete the Registration 

Request form and click Request Registration.   
 

Note: You can locate your PC ID by selecting Tools  Registration/Subscription from the top menu bar 
in ClearStream RFID and selecting the Registration tab. 

 
4. After receiving the Registration Code, select Tools  Registration/Subscription from the ClearStream 

RFID menu bar and enter this code into the Registration Code field on the Registration tab. 
5. Once this Registration Code is entered and verified, the total license count and remaining available 

licenses are displayed. 
 

3.5 Issuing Seats to RFID Readers, Bluetooth Beacon Gateways, or Custom Devices 

When registered, the ClearStream RFID Registration form will show the Status as Registered and show a table 
listing of any RFID readers or BLE Gateways that have been previously connected to ClearStream RFID. In most 
cases, the number of rows shown in this table will match that of the number of seats purchased. Follow the 
instructions below to issue a seat license to an RFID reader/BLE Gateway. 
 
Note:  With the Auto register new readers option enabled within the Registration dialog, any new 
devices connecting to ClearStream RFID will be automatically registered if there is a license seat 
available. 

 
1. Locate the Device ID you wish to license. If your ID is not listed, enter it to the Device ID field and click 

Issue. Proceed to step 3. 
2. Right-click the Device ID and select Issue.   
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3. You will receive a message confirming the registration of this reader.  
4. Select Yes and the reader now shows as Licensed in the License Status column. 

 
Note: Once you have registered all of your readers, you can export this license file to another PC if you 
plan to move your ClearStream RFID installation. For more information on this, see APPENDIX A.
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Chapter 4: Streaming Tags with the Sample Fixed RFID Process 
 
PTS provides a Sample Fixed RFID Process to utilize in testing RFID antenna read ranges, RFID tags and antenna 
placements. We also encourage users to use this after installing ClearStream RFID in order to better understand 
the basics of the configuration of a Stream Process. 
 
Note: To utilize the Sample Fixed RFID Process, you must first have a registered trial or full registered 
version of ClearStream RFID.  See Chapter 3: Registration for more information. 

 
4.1 Connecting an RFID Reader to ClearStream RFID 

The first step in utilizing the Sample Fixed RFID Process is to connect the RFID reader to the process.  To start 
connecting your reader, follow the steps below.  
 

1. In the Profile Configuration  Sample Welcome ProfileSample RFID Process window click the 
Devices button. 

2. In the Device Configuration dialog click the Add button and select the reader manufacturer you would 
like to connect (e.g., Zebra, Impinj, Alien etc.). 

3. Click in the IP/Hostname field and click the Find button when it appears. 
• Alternatively, you can simply enter the IP or Host Name of the reader (if known).  

4. Select your domain from the Find RFID readers on your network window. 
5. Click the Start button and wait for the available readers on your domain to appear. 
6. Highlight the reader you wish to connect to. Click Select. 
7. Click Close and save your project using the Save button. 

 
Note: When initially added, the device is enabled and configured with default settings. To further 
customize these settings, see Chapter 6. 

 
4.2 Connecting a Bluetooth Beacon Gateway to ClearStream RFID 

The setup for Bluetooth Gateways is different from that of most RFID readers. Bluetooth Gateways are typically 
configured to send beacons to a predefined IP Address or Host name. This is configured using the Gateways 
Configuration utility. For both supported gateway types (BluEpyc, BlueCats, and Minew), this is done using the 
web console of the Gateway.  
 

4.2.1  BluEpyc 

After attaching the Gateway to the network, log into the web console using a browser. The Gateway 
needs to be configured in Notification mode, and the IP address needs to be configured to be the IP 
address that ClearStream is running on. 
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4.2.2  BlueCats 

Attach the Gateway to the network and log into the web console. Select BlueCats->Setup Endpoints. 
Enter the ClearStream RFID IP address in the UDP EndPoint Host or IP address field. Click Save and 
Apply. 
 
4.2.3  Minew 

Attach the Gateway to the network and log into the web console using a web browser (e.g., 
http://xxx.xxx.xxx.xxx). Select Service and change Service Access to HTTP. In the Url field enter the 
address running ClearStream followed by the port and the Minew path (e.g., 
http://192.168.1.1:4405/api/v1/data/minew). Finally, if using Eddystone beacons make sure Upload 
Unknown is enabled. 

 
ClearStream RFID can now be setup to use the configured Gateways. Follow the same steps for setting up an 
RFID Reader above to configure the Gateway to stream beacons to the selected destination. There is a BLE 
Beacon List table prebuilt in the sample Microsoft Access database that can be used to collect all of the data 
from a beacon. 
 
4.3 Adding Custom Web/Network Devices  

ClearStream supports the streaming of data from a custom web enabled device. The communication can be 
handled using a TCP, UDP or HTTP connection to ClearStream. 
 
This data must be sent over as GET parameters to the ClearStream API URL, or as structured JSON as a POST. 
 
GET Sample (where 192.168.1.1 is the IP address of the ClearStream PC, and 123 is the Device ID): 
 
    http://192.168.1.1:4405/api/v1/data/custom/123?MAC=123341243&deviceid=123&myfield=myvalue 
 
POST Sample: 
 
    URL: http://192.168.4.137:4405/api/v1/data/custom/123 
    Body: '[{"MAC":"00:11:22:33:44:55'","DeviceID":"123","myfield":"my value"}] 
 
For information on supported devices and the configuration, see Appendix E: Custom Devices with ClearStream 
RFID. 
 
4.4 Starting and Stopping Devices 

With your device properly connected to the Sample Fixed RFID Process and a Destination data source 
configured, you will next start and stop the device to read RFID tags or Bluetooth Beacons.  To start and stop 
your device, follow the steps below.  
 
Note: Your read results may vary depending on the chosen antenna strength settings and the type of 
tags or beacons being tested.  

 
1. In the View menu or from the Navigation Bar, click the Start/Stop icon.   
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2. In the Start Stop Devices window click the Start All or Start Selected Button corresponding to the device 
you configured in Section 4.1 or Section 4.2.  

3. In the Activity Monitor Window, you will see data streaming through if properly configured. 
4. When finished with the stream click the Stop All or Stop Selected Button. 

 
4.5 Viewing Streamed Data 

After a device streaming cycle has been completed, data can be viewed from within ClearStream RFID. Follow 
the steps below to access the Data Viewer. 
 

1. In the View menu or from the Navigation Bar, click the Data Viewer icon. 
2. Review the tags or beacons read (you may need to hit the Refresh button to see the data). 
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Chapter 5: Creating a New Project and Streaming Data 
 
ClearStream RFID enables you to control your RFID Readers or Bluetooth Gateways as well as the moving of 
data to destination files through the use of Projects, Profiles and Processes.  
 
5.1 Creating a New Project 

A Project is a grouping of profiles. A project is typically saved at a company or business unit level. Creating a new 
Project is the first step in configuring a fixed RFID or Beacon environment. Follow the steps below to create a 
new Project. 
 

1. In the File menu, select New or click the New Icon on the toolbar. 
2. Proceed to Section 5.2 below to learn how to add a Profile. 
3. To save your project, select Save or Save As from the File menu or click the Save icon on the toolbar.  
4. To open an existing project, choose Open from the File menu or click the Open icon on the toolbar. 

 
5.2 Adding Profiles 

A Profile is a grouping of individual RFID or Beacon data collection processes. A Profile is typically set up to 
perform a discrete set of tasks in which each process is used to perform a specific function. Follow the steps 
below to create a Profile. 
 

1. In the Profile Explorer window click the New Profile icon. 
2. In the Profile Configuration window enter a Name for the Profile. 
3. Proceed to Section 5.3 below to learn how to add processes to your Profile. 
4. A Profile can be deleted, copied or moved up/down in order using the respective icons in the Profile 

Explorer. 
 
5.3 Adding Processes 

A Process is used to connect to your RFID reader or Bluetooth Gateway, set its parameters, and control where it 
streams data. A Profile typically contains one or more processes that perform related tasks.  Follow the steps 
below to create a new Process. 
 

1. In the Sync Process List window click the Add Process icon. 
2. Name the Process. 
3. Add a Comment to further detail the process. 
4. In the Source tab, select RFID/Bluetooth from the Type drop down. 
5. Select a device to use from the Device drop down. If the device you need has not been added yet, use 

the Devices button to add and configure any devices used in the application (See Section 4.1 for 
information on adding readers). 

6. In the Destination tab, select your preferred method of data destination from the Type drop down. 
7. You will then be presented with options specific to the Type selected. (See Chapter 7: Data Integration 

Settings for more information on further defining the different data types.) 
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8. Repeat steps 1-7 to add additional processes. 
9. Save your project. 
10. A Process can be copied, deleted or moved up/down in order using the respective icons in the Sync 

Process List window. 
 
5.4  Streaming Data 

Now that you have successfully configured your project you are now ready to start streaming data. Follow the 
instructions below to start a data stream. 
 

1. In the View menu or from the Navigation Bar click the Start/Stop icon.   
2. In the Start Stop Devices list, select the desired Device and click the Start Selected Button. Alternatively, 

click the Start All button to start all devices.  
3. When properly configured, you should see data streaming in the Activity Monitor Window. 
4. When finished streaming, click the Stop All or Stop Selected button. 

 
Note 1: RFID data streaming can be started based on a General Purpose Input (GPI) trigger (external 
button press or light/motion sensor). See Chapter 6: Device Settings for more information on setting 
this up. 
Note 2: Device data streaming can also be started using the ClearStream RFID Service. This allows the 
streaming of data to take place unattended without the Management Studio running. See Chapter 9: 
Running as a Windows Service for more information on setting this up. 
Note 3: Data streaming can also be started using the ClearStream RFID Web Service API see Chapter 11 
for more information. 

 
 
 
 
 



Chapter 6: Device Settings  

ClearStream RFID  Developed by Portable Technology Solutions 17 
 

Chapter 6: Device Settings 
 
The Device Settings within ClearStream RFID allow you to control when the data is streamed, set antenna 
power levels and configure the General Purpose Input and Output (GPIO) ports. To configure these settings, click 
the Devices button located on the Configuration form within your RFID process window. 
 
6.1  Scan Mode (RFID Readers only) 

The Scan Mode allows you to configure the read cycle of the RFID reader. These options, located on the 
Scanning tab, include Continuous, Timed and GPI Trigger. These options are explained below. 

6.1.1  Continuous 

With this option enabled, the RFID reader(s) is continuously powered; streaming data to your destination once a 
reader has been started. This is only recommended for high volume / rapid changing environments and can 
decrease the lifespan of your connected antennas. 

6.1.2  Timed 

With this option enabled, data can be streamed based on a timed Interval or run on a Daily Schedule by setting 
a specific time. This Scan Mode takes effect once the reader(s) has been started. 

Interval Scanning 
Begins a read operation after the specified interval and for the length of the duration. 

1. Interval – This value (in seconds) specifies the length of time between cycle reads. If this value is set to   
-1 the read will start immediately and run for the specified Duration. 

2. Duration – This value (in seconds) specifies how long the data stream should run once the reader has 
started streaming. 

3. Send tags when read – When enabled, tag data is sent from the reader as tags are read. Disabling this 
feature sends tag data at the end of a read duration (Recommended when using a Post Type of 
Overwrite in the Destination Options).  
 

Example: An Interval of 300 with a Duration of 15 means the reader will run every 5 minutes for 15 
seconds each time. Once the 15 seconds have passed, the reader will stop and start again 5 minutes 
later. 

 
Daily Scanning 
Daily scanning allows you to configure the read operations to be performed on selected days/times of the week, 
allowing you to set a Start and Stop time. 
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6.1.3  GPI Trigger 

With this option enabled, data will only be streamed when a signal is received from the specified Trigger Port. 
Items that can be connected to this type of port could be a push button/switch or a motion/light sensor. This 
Scan Mode takes effect once the reader has been started. 
 

1. Port – This value tells ClearStream RFID which General Purpose Input port on your RFID reader to 
expect the trigger from. If a trigger is received, the read will be started. 

2. Name – This value specifies a name for the GPI trigger. This value can be posted to your destination 
when the Start Event field is mapped. 

3. Duration - This value (in milliseconds) specifies how long the reader should run once the process has 
started streaming. 

4. De-bounce – Determines how long (in milliseconds) after a GPI Duration the reader must wait before a 
subsequent GPI event can trigger a read (Only available when multiple GPI ports are configured). 

5. Send tags when read – When enabled, tag data is sent from the reader as tags are read. Disabling this 
feature sends tag data at the end of a read duration. 

 
Example: You are looking to track items as they pass through an entry point but do not want to run the 
RFID reader constantly. In this case, a motion sensor can be connected to one of your readers GPI ports. 
When someone activates this motion sensor, it will then trigger the RFID reader to start the read, 
capturing the tag data when it passes though the entry point. The read will stop after the set Duration 
has expired. 

 
6.2  Antenna Settings (RFID Readers only) 

ClearStream RFID allows you to specify a name for each antenna and its power level. This helps in identifying 
the location where a tag was read. To modify antenna settings, click the Add button for each antenna you have, 
or right click in the Antenna Grid to choose from a selection of pre-built antenna types. The pre-built antenna 
types are dependent on the reader connected.  If these antenna settings are left blank, the default values are 
used. 
 

• ID – This correlates to the antenna port of your RFID reader and is a read only field. 
• Name – This allows you to name each antenna according to where it is located. 
• Power – This value (in dBm) controls the read power of each antenna. The higher this setting the further 

away tags can be read. The allowed values depend on which reader has been selected. 
• Tag Session – The Tag Session is a setting for making inventory events easier to manage. These sessions 

serve two purposes:  Determines how often a tag will respond to a query from the reader and allows for 
multiple readers to conduct independent inventories. Select from the 4 options below: 

a. S0 – Does not stay Inventoried at all. 
b. S1 – Stays Inventoried for .5 to 5 seconds. 
c. S2 – Stays Inventoried for at least 2 seconds. 
d. S3 – Stays inventoried for at least 2 seconds. 

• Antennas can be deleted by highlighting the antenna and clicking the Remove button. 
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More about Tag Sessions: All tags have internal flags that are set to A (I have not been inventoried) or B 
(I have been inventoried). When you read that the session target is A or B, it means that only tags with 
the flag in that position will be inventoried. The flag is flipped automatically when a tag is inventoried. 
Depending on which session setting is used and the capabilities of the tag, the flag always flips back to A 
after a time if it had previously been set to B. A is the tags default state. 

 
Tip: To reduce the probability of cross reading from adjacent rooms, the power level should be adjusted 
after thorough tag read testing. 

 
6.2.1 Antenna Settings for RTLS 

When configuring an RTLS system, ClearStream and the PTS RTLS Cloud rely on the antennas being correctly 
added to the antenna list. To help with the antenna setup for certain readers, you can right click in the Antenna 
list to quickly add antennas for the selected reader type. As an example, when using ATR7000s in an RTLS setup 
you can right click in the antenna list and select from the pre-built configuration options for the ATR700s. The 
most common and recommended antenna type is the ATR Left Hand Circular Polarization antennas. 
 
6.3 Tag Settings (RFID Readers only) 

Due to the many different tag types and storage capabilities, ClearStream RFID gives the ability to specify these 
values using the Tag Settings. In some cases, the tag specifications may not match the default and can be 
specified here. 
 

• EPC Tag Length – The length in bytes of the EPC memory bank of the tag. 
• User memory bank length – The length in bytes of the User memory bank of the tag. 
• TID memory bank length – The length in bytes of the TID memory bank of the tag. 
• Max tag count – Used for performance, this value should be set to the expected number of tags that 

may be in the readers read range at any one moment. 
• Convert EPC to ASCII – When enabled, EPC values are read in ASCII (text) format. 
• Convert User memory bank to ASCII – When enabled, the tag’s User memory bank is read in ASCII (text) 

format.  
• Read all memory banks during scan – When enabled, the tag’s TID and User memory banks are read 

and posted to the destination when mapped.  
• Decode SGTIN – When enabled, the GS1 SGTIN-96/198 values in a properly encoded GS1 tag will be 

parsed out into individual tag fields for each tag read. These fields will be added as mappable fields for 
use in the Field Mappings configuration of the Sync Process. 

o Include check digit – When enabled the Check Digit will be appended to the UPC/GTIN that is 
parsed from the GS1 encoded tag. 

 
Note: When the Read all memory banks during scan option is enabled and a tag is read that does not 
have a User memory bank value, the tag will not be sent to the destination. Only tags with the User 
memory bank encoded will be sent to the destination in this case. 
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6.4  Tag Events/Beacon Events/Data Events  

As tags, beacons, or custom events are received by ClearStream they can trigger different events to take 
place. These settings are located under Tag Settings for RFID Readers, Beacon Settings for Beacon 
Gateways, and Data Settings for Custom devices. The default events available are Tag visible and Tag no 
longer visible. Tag visible means that a tag has reported itself successfully to the device. Tag no longer 
visible is an event in which the tag has not reported itself to the device within a certain timeout period so it 
can be considered no longer in the field of view of the device or antenna. Finally, custom tag events can be 
created based on multiple tag events in a sequence. The specific Tag Event triggered will be posted to the 
database as a string when the TagEvent field is mapped.  

 
• Moderate tag reads/Moderate beacon reads/Moderate events – Enables or Disables tag event 

reporting. 
• Moderate by (RFID Readers and BLE Beacons only) – Defines at what level the tag events should be 

stored. By Device will maintain the tag state regardless of the antenna that read it. When in this mode if 
a tag is read by one antenna, followed by a second within the timeout timeframe it will only be reported 
once. By Antenna will maintain the tag state per antenna. So, in the same example, if a tag is read by 
one antenna followed by a second within the timeout timeframe it will be reported twice. 

• Timeout – The length of time in milliseconds to keep track of the tag state. At the end of this timeout 
the tag is considered no longer visible to the reader. 

• Visible description – The value as a string reported to the destination when a tag is scanned. 
• No longer visible description – The value as a string reported to the destination when a tag is no longer 

visible to the reader. 
• No tag read description – The value as a string reported to the destination when a read was triggered 

but no tags were read. 
• Report visible – Enables or disables whether or not the tag should be reported to the destination for this 

event. 
• Report no longer visible – Enables or Disables whether or not the tag should be reported to the 

destination when it is no longer seen by the reader. 
• Report no tag read – Enables or Disables whether or not an event should be reported to the destination 

when no tag is read. 
• Report again only after not visible – When enabled, a tag that stays in the field of view of the antenna 

will not be reported to the destination again until after it has left the field of view of the antenna. If this 
is disabled, a tag will be reported to the destination every n milliseconds defined by the timeout setting. 

o Report on value changed – When enabled, an event will only be sent to the destination when a 
field value of the current tag or beacon changes within the ClearStream buffer for the device. 
For example, if this option is enabled with the Antenna field selected, an RFID tag will be 
reported/sent to the destination when the current antenna changes for that tag. 

o Update Buffer Conditions – See below for more information. 
• Key Field (Custom and Group only) – Defines the row identifier for the data collected by the device and 

is used by ClearStream to maintain the state of an item to correctly report when this item is 
seen/unseen. 
 

Update Buffer Conditions 
Defines a set of conditions that must be met in order for the ClearStream Device buffer to be updated with 
the most recent tag, beacon, or event data. 
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• Update List (OR) – A list of conditions that are checked for every new tag, beacon or data event. If 
anyone of the items in the list are met (OR), the buffer will be updated with the new event data. 

• Update Conditions (AND) – Defines a list of conditions that must all be met (AND) in order for the new 
event data to update the buffer. 

o Field – The field used to check the condition. 
o Operator – The comparison operator that checks the new event data for the selected field 

against the value that already exists in that field in the buffer. 
o Value – The value used in the comparison with the Field that determines if the condition has 

been met. This is a read only field since the value is determined by the current value in the 
buffer. 

 
Use Case: You have a Group of Bluetooth Gateways that need to track which gateway is the closest to a 
beacon. Using the Update Buffer Conditions, you can configure the buffer to only change when the new 
Distance value is less than the old Distance value. In other words, we only record the beacon when it 
becomes closer to one gateway than another. 

 
Custom Events 
Custom Events define a sequence of tag events that need to occur before the custom event is triggered. This 
means that the tag needs to perform a certain sequence of events before it is reported. This is useful for 
things such as check in and check out applications, where you only want to report the activity of the tag 
after it has done something like pass by two antennas in a specific order. 

 
• Tag Event Description – The tag event value as a string that will be reported to the destination when 

this event occurs. Click the Add button to add a new custom tag event. Click the Remove button to 
remove the selected event. 

• Tag Sequence – Defines the list of events that need to occur before the tag will be reported to the 
destination. Click the Add button to add a new tag sequence. Click the Remove button to remove the 
selected sequence. 

o Field – The field used to check for an event. 
o Operator – The comparison operator that checks the field value against the entered value to 

determine if the event occurred. 
o Value – The value used in the comparison with the Field that determines if the event occurred. 

• Clear tag/beacon from buffer on event – When enabled, a tag or beacon that performs a custom event 
will be removed from the buffer. This can be used if the event needs to be immediately accessible again 
after it has been completed rather than needing to time out of the buffer. 

• IF – The If row defines a condition which must be met for the data to be checked in the Tag Sequence. 
For example, if you only wanted to check a sequence against tags that start with ‘1000’ the condition of 
EPC StartsWith ‘1000’ can be entered. 

• Minimum tag/beacon reads – Specifies the minimum number of reads of each RFID tag or BLE Beacon 
that needs to occur before the custom event will be checked. 

• Average RSSI/Distance – When enabled, the RSSI values, and the relative distance (for BLE only) will be 
averaged for each of the reads that will be processed during the custom event. 

 
Use Case: You are looking to track items as they pass through antennas on separate sides of a gate. If it 
is read by Antenna 1, then read by antenna 2, a custom event can be setup to mark this event as “Check-
In”. To do this, create an event called Check-In, then add two sequences. The first will be where 
Antenna Equals Antenna: 1, then, add a 2nd sequence where Antenna Equals Antenna: 2. This will now 
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only send a read to the destination once the item has passed over Antenna 1 first followed by Antenna 2 
and will report the event as “Check-In” to the destination. Note that Antenna values used for the 
sequences above will depend on what you have named your antennas in the Antenna settings section. 

 
Note: When using Custom Events, Tag visible and Not visible settings will be ignored and should not be 
used. 

 
Send Delay 
The Send Delay feature limits how often event data is sent to the destination. When Enabled, tag, beacon, 
or other event data will only be sent at an interval specified in the Interval and Max events per send fields. 

• Interval – The length of time (in milliseconds) between sends of event data to the destination. 
• Max events per send – The maximum number of events that will be sent to the destination for 

every interval. 
 
6.5  Custom Fields  

ClearStream RFID provides a number of default fields that are collected every time a reader scans a tag. The 
Custom Fields tab allows a user to define extra fields that can be static values, or values based off of other data 
collected by the reader. For instance, a tag’s user memory bank may contain a number of fields that can be 
parsed into separate values. These values can be parsed and used in the field mappings of the configured sync 
process as custom fields. 
 

• Add – Adds a Custom Field, or a Value of the selected field to the list. 
• Remove – Removes the selected Custom Field or Value from the list. 

 
Custom Fields Settings 
A Custom Field is made up of one or more Values. These values can be either a Static value or a value from 
another field collected by the reader. Conditions can also be defined to supply the value if the condition is 
met. Finally, a function can be configured which defines how the value is parsed from the source data. 
 
• Field Name – The name of the custom field being configured. This is the value that will be displayed in 

the Field Mappings after the field has been created. 
 

Custom field Value 
The Custom field value is the value that will be supplied to the destination when a tag is read and sent to the 
destination. 
 
• Name – The name for the selected Value. 
• Type – The type of value to use and can be set to Static or From field. 

o Static – When enabled, a value must be entered to the text field below. This will supply said 
value to the destination every time a tag is scanned. This is commonly used to send required 
data to the destination every time a tag is scanned that is not otherwise collected by the reader. 

o From field – When enabled, a field must be chosen from the drop down that you wish to pull 
this data from. The UserMemoryBank is a common selection for this, and further manipulation 
of this data can be done using the Function option below. 
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i. From moderated tag – When enabled, the custom field value is retrieved from a tag 
that is within the Moderated Tag Table. Use the Condition configuration as the filter to 
select the desired tag in the moderated table. If no tag matches the condition the 
custom field value will be an empty string. 

• Function – Determines the function used to grab data from the field supplying the value. This can be 
one of three parsing functions: LEFT, MID, or RIGHT. Only available when From field is enabled. 

o LEFT – Set the function to LEFT if you wish to do a LEFT parse based on the entered Index. 
o MID – Set the function to MID if you wish to start the parse at a specific index and then define 

the length to parse from that starting index value. 
o RIGHT – Set the function to RIGHT if you wish to do a Right parse based on the entered index. 

 
 
Use the value if condition met 
In this section, users can require a specific condition to be met when using custom fields. 

 
• Condition – Defines the condition that must be met for this Value to be set for the Custom Field. 

o If – The field the Condition is to be based on. 
o Operator – The comparison operator that checks the field value against the entered value to 

determine if the condition is met. 
o Value – The value used in the comparison with the Field that determines if the condition has 

been met. 
 
6.6  Using GPO (RFID Readers Only) 

ClearStream RFID allows you to trigger external devices connected to your RFID reader’s GPIO ports based on 
the set alerts. For example, these can be used to turn on/off lights or even sound audible alarms.  From the GPO 
tab, click the Add button for each output you want to trigger and follow the instructions below. 
 

1. Port – Set this value to the General Purpose Output port number of your RFID reader that your output 
device is connected to. (Depending on your reader this value is usually between 1-4) 

2. Alert Type – Select the type of alert. Available options are described below. 
a. API – Occurs through the use of the ClearStream command API. 
b. Destination Data Delete – Occurs when a row in the destination is deleted. 
c. Destination Data Insert – Occurs when a row is added to the destination. 
d. Destination Data Update – Occurs when a row in the destination is updated with new data. 
e. Inventory Started – Occurs when a reader switches to the RFID scanning state. 
f. Inventory Stopped – Occurs when a reader switches to the RFID stopped state. 
g. Moderated Tag in Buffer – Occurs when there are tags in the event buffer. This will only occur 

when Moderate Tags Reads is enabled. 
h. No Tag Read During Inventory – Occurs when an RFID Inventory is performed, and no tags were 

read. 
i. Send Complete – Occurs when reader sends a tag to the destination that matches the set 

condition. 
j. Tag Event Any – Occurs with any type of tag event including Visible, Not Visible, Visible again. 
k. Tag Event Not Visible – Occurs only with a tag event type of No Longer Visible. 
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l. Tag Event Visible – Occurs only with a tag event type of Visible. 
m. Tag Read – Occurs when the source of data is populated with a new row. This will occur when 

an RFID tag is read by the reader. 
3. Port State – Set to True or False, controls whether the port is turned on or off on the trigger. 
4. Duration – This value (in ms) is the amount of time the output will run each time it is triggered. 
5. Profile ID – This ID specifies the configured profile which will trigger the alert type and power up the 

port. Not used for API, Inventory Started, Inventory Stopped, Moderated Tag in Buffer, No Tag Read 
During Inventory, Send Complete, Tag Event Any, Tag Event Not Visible, Tag Event Visible, and Tag 
Read alert types. 

6. Process ID – This ID specifies the configured process which will trigger the alert type and power up the 
port. Not used for API, Inventory Started, Inventory Stopped, Moderated Tag in Buffer, No Tag Read 
During Inventory, Send Complete, Tag Event Any, Tag Event Not Visible, Tag Event Visible, and Tag 
Read alert types. 

7. Condition – The value that must be met for the alert to be triggered. This is typically a 1 for condition 
met or 0 for condition not met. Not used for API, Inventory Started, Inventory Stopped, No Tag Read 
During Inventory, Tag Event Any, Tag Event Not Visible, Tag Event Visible, and Tag Read alert types. 

8. To delete an Alert, highlight the Alert and click the Remove button. 
 
Example: Using a combination of an Alert with an output trigger, you can sound an audible alarm when 
an item passes an entry point that is not an authorized item listed in your destination data source. 

 
Example 2: Using Send Complete to turn on a light if a reader was started but no tags were read. Using a 
GPI Input to trigger the reader to start and run for a set duration, with a condition set to 0, a light can be 
turned on if no tags were sent to the destination after the read has completed. 

 
Note: Since the number of devices that can be controlled by GPIO is limitless, feel free to contact us 
directly for assistance when using this function.   

 
 
6.7  Device Options (Zebra/Feig/Alien Readers, Beacon Gateways, Custom Devices Only) 

The Device tab is customized based on the current type selected. Currently, Device options are only available for 
Zebra, Feig and Alien RFID Readers, Bluetooth Beacon Gateways or Custom Devices. 
 
6.7.1  Zebra Device Options 

6.7.1.1  Tag Reporting 
The Tag Reporting options allow the reader to send tag events to a database field identifying the type of 
read event that occurred. These tag events are made up of three different types: New tag, Tag invisible, 
and Back to visible. These event types are described below. To disable tag reporting, uncheck the Enable 
tag event reporting checkbox. We recommend using the ClearStream Tag Events option instead of the 
built-in reader functionality as it offers more functionality and flexibility in moderating tag reads. 

 



Chapter 6: Device Settings  

ClearStream RFID  Developed by Portable Technology Solutions 25 
 

• New tag – Occurs when a currently unseen tag is read by the reader. 
• Tag invisible – Occurs when a tag has not been seen by the specified timeout period. 
• Back to visible – Occurs when a tag that was once seen by the reader comes back into range and 

is read again by the reader. 
 
The following options can be set for each Tag Reporting type: 
 

• Tag Events – Controls when or if the event should be written to the database. 
o Immediate – Event is immediately reported back to the database. 
o Moderated – Event is reported after the specified Timeout value set. 
o Never – Event is not reported back to the database. 

• Description – Description of the tag event. This gets posted to the tag event field in the 
database identifying the type of tag event that occurred. This can be customized or left at the 
default setting. 

• Timeout – Used with Moderated only, sets the timeout (in ms) for the event to occur. 

6.7.1.2 Tag Masks 
Tag Masks allow the reader to pre filter tags that are included in an inventory process based on a Tag 
Mask of the EPC memory bank. This will block tags that do not match the mask from being reported to the 
destination. It can also help in an environment where only a certain subset of tags should be scanned. 
Note, when converting EPC values to ASCII, the ASCII value of the Mask must be entered. 
 

• (+) Add Mask – Click the Add (+) Mask button to add a new mask to the list. The Mask is made 
up of two things, the mask value, and the antenna that should use the mask. The mask value 
should be a tag prefix that should be used for the filter. For example, if only tags that start with 
E200 should be included in the inventory scan, then a tag mask of E200 should be entered as the 
tag mask. The Antenna should be set to the port of the Antenna you wish to apply the tag mask 
to. Please note that this antenna must be entered in the Antenna List. 

• (-) Remove Mask – Click the Remove (-) Mask button to remove the selected Tag Mask. 

6.7.1.3  Reader Management 
This option allows you to restart your RFID reader directly from the ClearStream RFID software. This 
enables you to reset your reader without having to unplug the device or login to its management console. 
Located on the Management tab, the following options are available: 

 
• Username – This is the username initially set for your RFID reader. 
• Password – This is the password initially set for your RFID reader. 
• Secure Mode – Choose from HTTP or HTTPS. 
• Reader Type – Choose between FX, RD or XR. (These are models of Zebra RFID readers) 
• Restart Reader – Press this button to proceed with the Restart. You will be prompted to confirm 

the restart and then prompted again when the restart has finished. 
• Restart reader if connection fails – When enabled, if a connection is lost to the reader and a 

reconnection attempt fails, ClearStream will attempt to reboot the reader. When the reboot is 
complete, it will attempt to restart the reader. 
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Note: In order for this to function, it must be a Zebra RFID reader and requires that you have previously 
set up a username and password. The username and password must also be entered here for this to 
work. 

 
6.7.2  Alien Device Options 

6.7.2.1  Restart Reader 
Click this button to restart the Alien reader from within ClearStream. 
 

• Restart reader if connection fails – When enabled, if a connection is lost to the reader and a 
reconnection attempt fails, ClearStream will attempt to reboot the reader. When the reboot is 
complete, it will attempt to restart the reader. 

6.7.2.2  Ports 
You can set what ports the Alien reader events servers will listen for events on. Click Apply to make the 
changes take effect. 

 
• Tag Events: Set the port for the tag events server. The default is 7798. 
• IO Events: Set the port for the IO events server. The default is 7799. 

 
6.7.3  Feig Device Options 

6.7.3.1  Restart Reader 
Click this button to restart the Feig reader from within ClearStream. 

 
• Restart reader if connection fails – When enabled, if a connection is lost to the reader and a 

reconnection attempt fails, ClearStream will attempt to reboot the reader. When the reboot is 
complete, it will attempt to restart the reader. 

6.7.3.2  Network Settings 
The network settings allow you to adjust the IP address, Subnet mask, and whether or not DHCP is 
enabled on the reader. These can be configured as required to connect the reader to a network. 

6.7.3.3  Operating Mode 
Feig readers can run in different modes. This affects how tags are captured and recorded by the reader. 
 

• Host Mode – All commands are issued by ClearStream and performed on the reader in a single 
call. This is the default mode. 

 
• Buffered read mode – In Buffered read mode, the reader will store all tags it scans on the 

reader itself until ClearStream requests all tags scanned. This mode is faster than Host mode, 
however when a reader is stopped using the ClearStream interface, the Feig reader will continue 
to scan for tags. The tags it scans won’t be sent to ClearStream until they are Started again using 
the ClearStream interface. 
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• Notification Mode – Similar to the Buffered Read Mode, however the reader itself will initiate 
the connection and remotely send the tag data back to the IP address and Port specified. This IP 
and port combination should be a PC running ClearStream, and the port should be unique for 
each reader configured. Make sure all Ports used are open. This mode is useful for a remote 
installation of the reader where direct network access from the PC might otherwise not be 
possible. The Keepalive option tells the reader to communicate home at a set interval so 
ClearStream can detect a lost connection. 

 
6.7.4  Bluetooth Beacon Gateway Device Options 

Gateway type 
Used to set the Gateway Type sending Beacons to ClearStream RFID. The currently supported options are 
gateways manufactured by BluEpyc, Minew, and BlueCats. Select the Type matching the gateway being 
used. 
 
Listening Port 
The port that ClearStream will listen on for Beacons reported by the Gateway. This must match the port 
configured using the Gateway’s web console configuration. ClearStream will default this value to the 
default set by the manufacturer. 
 
Scan for iBeacon 
When checked the Bluetooth Gateway will scan for and report Bluetooth beacons which follow the 
iBeacon protocol. 
 

iBeacon Filtering 
The iBeacon Filtering options allow filters to be applied to iBeacons. Only beacons that match 
the filter will be reported. 

 
• UUID – If a value is present, only iBeacons with a matching UUID will be scanned for and 

reported. 
• Major – When the value is greater than or equal to 0, only iBeacons with a matching Major 

number will be scanned for and reported.  
• Minor - When the value is greater than or equal to 0, only iBeacons with a matching Minor 

number will be scanned for and reported. 
 

Scan for Eddystone URL 
When checked the Bluetooth Gateway will scan for and report beacons with an Eddystone URL frame-
type. 
 
Scan for Eddystone TLM 
When checked the Bluetooth Gateway will scan for and report beacons with an Eddystone TLM frame-
type. 
 
Scan for Eddystone UID 
When checked the Bluetooth Gateway will scan for and report beacons with an Eddystone UID frame-
type. 
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Eddystone Filtering 
The Eddystone Filtering options allow filters to be applied for Eddystone UID beacons. Only 
beacons that match the filter will be reported. 

 
• Namespace – When a value is present, only Eddystone UID beacons will be reported with a 

matching Namespace. 
• Instance – When a value is present only Eddystone UID beacons will be reported with a 

matching Instance. 

6.7.4.1  Gateway Device ID and Registration 
Bluetooth gateways have different ways of reporting their identification. This identification is required for 
use in ClearStream registration as well as reporting an accurate location when Bluetooth beacons are 
recorded. Depending on the type of gateway being used the process of retrieving the Device ID can differ.  
 

BluEpyc 
ClearStream can retrieve the Device ID (Board ID) of a BluEpyc Gateway by connecting to it after a 
valid IP address has been entered. This Device ID is called the Board ID within the BluEpyc 
configuration utility. The Board ID should be set uniquely for each gateway by using this BluEpyc 
configuration utility. To access the BluEpyc configuration utility, use a web browser to navigate to the 
IP address of the gateway. The Board ID will be displayed on the home page of this utility and can be 
changed from any value between 1 and 255. After changing the ID click the Save and Apply button. 
 
BlueCats 
When using a BlueCats Gateway the Device ID should be set to the MAC address of the gateway. This 
can be found printed on the bottom of the gateway, or it can be found using the web configuration 
utility under the NetworkInterfaces section. 
 
Minew 
When using a Minew gateway the Device ID should be set to the MAC address of the gateway. This 
can be found printed on the underside of the gateway, or by using the web configuration utility 
found in the Network settings. 
 

6.7.5  ClearStream On-Board Device Options 

ClearStream On-Board is an embedded application that runs on the reader itself. This application allows for a 
highly reliable distributed setup of a ClearStream client and is highly optimized for installations that may not 
always have data connectivity to the destination database or system. The application has the capability to “store 
and forward” tag data when a remote connection is available. ClearStream On-Board requires a subscription 
service to the online web portal to operate. This gives access to an online portal where a user can configure and 
access all of the readers in an environment. The web portal displays device status so a user can quickly see 
devices that are online or disconnected. 
 

Configuration Settings 
The configuration for a ClearStream On-board client is performed using the ClearStream Web Portal. This 
configuration requires a subscription account and allows remote configuration and viewing of device 
status through a web browser. 
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Device ID 
The Device ID needs to be configured in the Reader List so that ClearStream knows which reader is 
supplying the tag data. You can find the Device ID using the online web portal. Copy the Device ID listed 
into the Device ID field within the reader list configuration for each device used in the configuration. 
 
Date End Point 
When using ClearStream RFID to stream the data coming from ClearStream On-Board, the Data End Point 
setting within the web console needs to be set to one of the options displayed in the settings for an On-
Board reader. Copy the appropriate End Point listed into the web portal for the reader you would like to 
configure. If using the Management Studio, select the Management Studio Data End Point URL. If using 
the Windows Service, select the Windows Service Data End Point URL. 
 
Connecting to an Onboard reader through the ClearStream software enables users to stream RFID tag data 
to the supported destination types covered in Chapter 7. There are some limitations to using an On-Board 
reader vs. a directly connected reader in the ClearStream software and are outlined below: 
 

• On-Board does not support the ability to set a Daily Schedule designating when the reader 
should be started/stopped. 

• On-Board only supports one GPI (General Purpose Input) Trigger per reader for 
starting/stopping a reader. 

• On-Board does not support the use of Custom Events defining how/when tags are sent to the 
destination. 

• On-Board can only report the EPC and User Memory banks of an RFID tag and does not read the 
TID. 

• On-Board does not support the use of Custom Fields for sending additional data with tag reads. 
• On-Board GPO (General Purpose Outputs) cannot be triggered upon Destination Data Insert, 

Update, or Delete. 
 
6.7.6  Cognex and Custom Device Options 

ClearStream supports the streaming of Cognex scanners along with custom data that is sent to the application. 
This can be data sent over a few communication channels which include HTTP, TCP, or UDP. These options are 
configured using the Cognex or Custom Device Options form as appropriate. 
   

Listener type 
The Listener type option specifies how ClearStream should be listening for the custom device’s data.  The 
three options are HTTP, TCP, and UDP and are outlined below. 

 
HTTP 
When selected, the HTTP option causes ClearStream to start listening for http web requests. The 
URL for making these requests will be shown on the dialog when selected. Data can be sent to 
ClearStream using either a GET or a POST request. When sending via a GET request the field data is 
supplied as a Key-Value pair as the URL parameters. When sent as a POST request the data needs to 
be structure as a JSON array, made up of Key-Value pairs for each field. In both cases the Key values 
need to match the fields that are added to the device. Examples of this can be seen in Appendix E: 
Custom Devices with ClearStream RFID  
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TCP/UDP 
When selected, ClearStream will start a TCP, or UDP listening server on the Listening port specified. 
Make sure this port is open. The data structure sent in this connection must be a JSON array of Key-
Value pairs. The Keys must match the fields specified in the Custom device.  A sample of JSON 
structure can be found in Appendix E: Custom Devices with ClearStream RFID 

 
6.7.7  Group Options 

A ClearStream Group allows a number of devices to be added to a logical grouping. Every device that is a 
member of the group will send their reported events to the Group. The Group can then be mapped to a 
destination as a single unit. This eases the mapping of many devices that all require the same destination and 
field mappings. Groups are also used when configuring a PTS RTLS system. Use the Device tab of the Group to 
add the devices that should be members of that Group. To remove a device, right click on the device from the 
Devices Tree and click Remove. 
 

6.7.7.1 RTLS Configuration for a Reader Group 
In order for RTLS data to be generated and sent to the PTS RTLS Cloud a Group must be configured with all 
of the readers that are part of the environment. The section describes the configuration options for 
settings up an RTLS system. Important points to note are that all of the readers must have their antennas 
configured, and the Key Field must be set to EPC for the entire Group. 

 
Generate RTLS Data 
When enabled, the data that is sent to the Group from the members of that Group will be processed to 
generate RTLS data. It is also important to set the correct Key Field for the Group when generating RTLS 
data. After adding at least one RFID reader to the Group change the Key Field option on the Tag Settings 
tab to EPC. 
 
RTLS Environment Settings 
Click to open the RTLS Environment Settings dialog. This dialog allows for customization of the RTLS 
processing algorithm. These values will affect the accuracy of the RTLS data and can be customized for 
each environment. 
 

Settings 
The Settings tab contains values that can be adjusted to try and improve the RTLS location accuracy. 
These values can be adjusted based on the results of some RTLS testing. The defaults will work in most 
cases. 

 
Process tag delay 
Defines the length of time between each RTLS processing, and send to the server, in milliseconds. 
The minimum time is 30 seconds, and the default is 5 minutes. Increasing this time will allow for 
more tag data to be processed potentially resulting in more accurate location data. 
 
Tag valid time 
The length of time in milliseconds that a tag read will be remembered and used in the RTLS 
calculation. The longer this time is set the slower the tag will react to movement. 
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Max tag temps per cell 
The maximum number of tags reads to remember per cell/antenna. This can be used in high 
population environments to reduce the tag load. 
 
Min tag temps per cell 
The required number of tag reads per cell/antenna to be used in the RTLS calculation.  
 
Minimum RSSI 
The minimum RSSI value of a tag read that will be recorded and used in the RTLS calculation. This 
can be used to filter out faint tag reads if needed. 
 
Max RSSI diff from strongest 
Defines the maximum difference between the strongest tag read and any new tags being recorded 
for a cell/antenna. This can be used to throw away faint tag reads, if a stringer tag read has already 
been recorded. 
 
Number of temps to sample 
When this value is set the calculation will switch to only accumulate RTLS averages until this value is 
hit. This can help with accuracy of the RTLS but can result in reduced reads in certain environments. 
 
Median 
When enabled the RTLS engine will determine position based on a median calculation rather than 
the default average. 
 
Consider Neighbor cells 
When enabled the RTLS engine will include neighboring cells/antennas to try and determine best 
position. This can help improve accuracy in certain environments, but slow the processing down, 
especially with large populations of tags. 
 
Enabled time weight 
When enabled the RTLS engine will gradually decay the weight of a tag read as the read gets older. 
This has the effect of dropping the importance of tag reads on the calculation the further they are 
from the present 
 
Tag full weight time 
The length of time in milliseconds that a tag read is considered full weight (most effect on the 
result). 
 
Decay rate 
The rate of decay, as a decimal percent, of weight after the full weight time. 
 
Min elevation change 
The minimum amount of elevation change from one RTLS calculation to the next before the tag is 
reported to the destination. Increasing this value can help reduce the amount of data sent to the 
destination and the flicker of tag movement due to variations in the RTLS calculation. 
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Min azimuth change 
The minimum amount of azimuth change from one RTLS calculation to the next before the tag is 
reported to the destination. Increasing this value can help reduce the amount of data sent to the 
destination and the flicker of tag movement due to variations in the RTLS calculation. 
 
Enable RSSI Adjustments 
When enabled tag read RSSI values will be adjusted by the specified amount for the selected 
elevation. This can help reduce tag signal strength for certain elevations if the read power is 
generally stronger. This can help with tag movement by making the tag move faster passed these 
stronger elevations. 

 
Filters 
The Filters tab contains a text area to add filters that define the EPC values to use in the RTLS engine. 
One EPC should be added per line, and only matching EPCs will be considered. Leave it blank to scan for 
all RFID tags. 

 
Detail 
The Detail tab is used for debugging purposes. 
 
 

6.7.8  Zebra IOT Connector Device Options 

Zebra readers have two connection methods available. The first was described in Section 6.7.1, the second is 
using the Zebra IOT Connector interface. The Zebra IOT Connector interface supports some additional options 
depending on the Zebra reader type. It also supports the Zebra FXR90 device that is not currently supported 
using the other method. 
 
Zebra Device Login 
This section configures the connection to the reader. The username and password must be set for the 
connection to be made. 
 

Username 
The Username of the device. The default is admin. 
 
Password 
The Password of the device. The default is change, however this is generally required to be changed when 
first connecting to the reader’s web user interface. 

 
Handle management events 
When enabled the reader will send status messages to ClearStream to indicate device health and 
configuration. To use this feature, the URL of ClearStream needs to be configured as the Management Event 
Interface within the Zebra web interface of the device. This setting can be found in the IOT Connector 
Configuration on the device. The URL needs to be as per the following: 
http://{IP_ADDRESS_OF_CLEARSTREAM}/api/v1/ziotc/management/{device_id} This URL is also available by 
copying it from the read-only Management endpoint text box on the Device tab. If using the windows 
service, the correct port must be entered in the URL. 
 



Chapter 6: Device Settings  

ClearStream RFID  Developed by Portable Technology Solutions 33 
 

Important Note: In order to use GPI triggers with the Zebra IOT Connector interface, the management 
events settings must be configured and Handle management events must be enabled. 

 
Data Endpoint 
The Data Endpoint configuration  specifies where the reader should send tag data. This can be one of the two 
option listed below: 
 

ClearSteam_Windows 
Use the ClearStream_Windows option when tag data should be sent back to ClearStream, and then to the 
mapped destination. 
 
 ClearStream Host 

This should be set to the IP Address of your PC running the ClearStream RFID software. This will default 
to the PC’s current IP Address. 

 
 Management endpoint 

This URL can be copied to the Zebra Web Management interface of your reader as the Management 
endpoint when Handle management events is enabled per above. 

 
PTS_Cloud 
The PTS Cloud is a subscription service that gives users a full end-to-end cloud hosted solution for their 
ClearStream and TracerPlus data. With a subscription to this service a user can configure the reader to send 
data directly to the cloud using this option. 
 
 Data Endpoint 
 Set this to the PTS Cloud URL you wish to send data to. Contact PTS for more information. 

 
Tag  Reporting 
The Tag Reporting section has settings for configuring how often tags are sent to the destination endpoint. 
These features are not enabled when Tag Moderation settings are enabled for the reader. To configure these 
settings disable Tag Moderation on the Tag Events tab. 
 

Interval 
The Interval is the amount of time in seconds that needs to pass for the tags that have been read to be read 
again and recorded. These recorded tag reads will be sent to the destination. This can be set PerAntenna or 
RadioWide. 
 
Enable tag batching 
When enabled tags will be queued up on the reader before they are sent to the destination. This can help  
reduce bandwidth required for sending tag data. 
 

Reporting Interval 
The Reporting Interval defines the length of time in milliseconds for each batch to be sent to the 
destination. 
 
Max payload 
The Max payload defines the maximum size in bytes that should be sent to the destination in one batch. 
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Enable tag retention 
The Enable Tag Retention option, when enabled, will instruct the reader to save tag data to the disk of the 
device. This allows for data to be retained in the case of network outages, or even power loss. 
 

Throttle 
The Throttle defines the rate at which events/tag reads should be sent to the destination upon network 
reconnection. This is defined as events per second. 
 
Max number of events 
The maximum numbers of events/tag reads to retain on the device during a network outage. 
 
Event retention time 
Defines how long, in minutes, to retain events/tag reads. 

 
Operating Mode 
The operating mode defines how the read is configured for scanning for RFID tags. Currently there are two 
options, Custom and Directionality. The Directionality mode is only available for Zebra ATR7000 devices, so all 
other readers should be configured as Custom. 
 
GPS 
The GPS Settings are currently only available on Zebra FXR90 devices. When enabled GPS latitude, longitude, 
and Last Report Time values are recorded by the reader, and set as mappable fields to the destination. 
 

Enabled 
When Enabled the GPS values will be sent to the mapped fields of the destination. 
 
Refreshing interval 
The rate in milliseconds that the GPS values will be refreshed. The default value is 30000 (30 seconds). The 
GPS will also be refreshed at the time of starting the reader. 

 
Directionality 
The Directionality settings are available when the Operating Mode of the reader is set to Directionality. These 
features are currently only available for Zebra ATR7000 devices. The ATR7000 supports directionality by allowing 
for 4 or 6 zones to be configured. In 4 Zone mode the reader sets up one central North/South Lane, and two 
East/West Zones that are outside of this lane. The Lane is configurable in size and orientation using the settings 
within the Directionality group box. The 6 lane mode defines two North South Lanes that are configurable using 
these same settings. 
 

Reader height (ft) 
The height from the floor of the installed reader in feet. 
 
Tag height 
The average height of the tags to be tracked from the floor in meters. 
 
Orientation 
Defines the Orientation of the lanes created for reporting direction. The default of 0 sets the lanes up in the 
North/South direction with regards to the North point of the reader (refer to the ATR7000 user guide for the 
North point). By adjusting the orientation in degrees the direction of these lanes will rotate clockwise from 
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0. As an example, a value of 90 would rotate the lanes to an East/West orientation with regards to the North 
point on the reader. 
 
Zone plan 
The number of zones to configure. Currently there are two options, 4 and 6. When 4 is selected, Zone 1 is 
North, Zone 2 is South. This creates a lane for directional detection of tags. Zone 3 is West, and Zone 4 is 
east. When configured for 6 zones, there are 2 lanes defined in the 0 degree orientation. Zone 1, and Zone 2 
are North, South respectively on the west side. Zone 3, and Zone 4 are North and South respectively on the 
East side. Finally Zone 5 is west of the lanes, and Zone 6 is to the east. 
 
Inner zone width 
The width of the north south zones defined in feet. 
 
Zone extension 
The distance in feet that one zone extends into the other zone. This changes the transition point of the lane. 
It is specified in feet  between -50 and 50. 
 
Hysteresis distance 
This defines the number of feet a tag must move into another zone before it is allowed to move back into 
the previous zone. 
 
Report updates 
By default only 3 states of a tag are reported in directionality mode. The first is a new tag being scanned in a 
zone, the second is a tag transitioning from one zone to the next , and the third is a tag that is no longer 
visible to the reader. When Report Updates is set to something greater than 0, tags that are within a zone 
and have not moved will be reported by the value specified in the Report updates setting in seconds. 
 
Beam config 
Defines the possible beam configurations of the ATR7000 to use. This setting can be used to try and tune 
performance for the environment. 
 
Polarization 
Defines the beam polarization to be used. This setting can be used to try and tune performance for the 
environment. 
 
Zone names 
The zone names to be used. These values will be reported in the tag data as tags are sent to the destination.
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Chapter 7: Data Integration Settings  
 
ClearStream RFID allows you to stream data read by your readers to the data destination of your choice. These 
options include SQL Server, ODBC databases, Microsoft Excel spreadsheets, Text files, and SMTP/URL Endpoints. 
  
7.1 Destination Type 

Available choices are ODBC, SQL Server, Excel, Text and Template. You are presented with different 
configuration options based on the Type chosen. The sections below explain each Type in more detail.  
 
7.1.1  ODBC 

Choosing ODBC allows you stream data to most ODBC databases including (but not limited to) SQL Server, 
MySQL, Oracle and MS Access. When ODBC is selected, the following parameters can be set: 
 

• ODBC Datasource – This is a list of available data sources already configured in the Data Sources (ODBC) 
component of your Windows operating system. Select your desired data source here. 

• Schema – Enter your database Schema name (Optional). 
• Username – If your database requires a username enter it here. 
• Password – If your database requires a password enter it here. 
• Login – Click this button after entering the Username and Password. 
• Table – Populated after selecting your ODBC Datasource and entering the Username and Password, this 

allows you to select the specific table, query, view or stored procedure you want to stream the data 
reads to. 

 
Note: To create a new Windows data source, see APPENDIX C: Creating a Windows Data Source. 

 
7.1.2  SQL Server 

Choosing SQL Server allows you to sync data to and from a SQL Server database. This can also be accomplished 
using the ODBC Type described above, however there are some speed improvements when using the SQL 
Server type. When SQL Server is selected, the following parameters can be set: 
 

• Server – The SQL Server data source specified by IP address or host name. 
• Database – The database instance required for the process. 
• Schema – Enter your database Schema name (Optional). 
• Authentication – The user authentication type to use to access the SQL Server database. 
• Username – If the database requires a username enter it here. 
• Password – If the database requires a password enter it here. 
• Login – Click this button after entering the Username and Password. 
• Table – Populated after entering the Username and Password, this allows you to select the specific 

table, view or stored procedure you want to stream the data reads to. 
• Configure Advanced options as needed. 



Chapter 7: Data Integration Settings  

ClearStream RFID  Developed by Portable Technology Solutions 37 
 

 
7.1.3  Excel 

Choosing Excel allows you to stream your data to a Microsoft Excel spreadsheet. When Excel is selected, the 
following parameters can be set: 
 

• Excel Workbook – Click the Folder icon and select the Excel workbook you wish to stream data to. 
• Worksheet – Populated after selecting your Excel Workbook, this allows you to select the specific sheet 

within the workbook to stream the data to. 
• Advanced – After clicking the Advanced button, you can set the Start Row in which the data streamed 

should start in the excel sheet. This is useful if you have column names and want to start on row 2. 
 
Note 1: When streaming data to an excel sheet, the workbook must be closed for the process to run 
properly. 
Note 2: When using Excel, it is not recommended to use a Continuous read cycle for your RFID reader. 

 
7.1.4  Text 

Choosing Text allows you to stream data to a text file in a configurable format. When Text is selected, the 
following parameters can be set: 
 

• Select Folder – Click the Folder icon and specify the folder where your text file resides. 
• Filename – Populated after a folder is selected, this will display all .txt files found in the specified 

directory. Select the text file you wish to stream data to. 
• Create File – If the text file does not exist, you can enter the name here and click this button to create 

the file. This file can be named with a .txt or .csv file extension. 

7.1.4.1  Advanced Text Options 
In this area, you can specify the type of delimiter to use, set file uniqueness and define field attributes. See 
below for the settings available in this section. 

 
• Delimited – Sets the type of delimiter to use. 

o Tab – Data fields are separated by a tab. 
o Semicolon – Data fields are separated by a Semicolon (;). 
o Comma – Data fields are separated by a Comma (,). 
o Space – Data fields are separated by a single space. 
o Other – Data fields are separated by the character of your choice. 
o Text Qualifier – Surrounds each field of data with an Apostrophe (‘) or Quote (“). 

• Fixed Width – Each field is separated by a set width and is defined in the Text File Fields section. 
• Static File Suffix – Will append the value defined here to the text file name. 
• Create Unique File Suffix –Creates a unique file for each data stream. This is based on a FileCounter 

or DateTime and is appended to the file name.  
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• Text File Fields – Define field names and Fixed Width settings here. Fields can be added, removed or 
moved up/down using the navigation bar buttons. 

o Name – Specify a field name for each field. This is useful when mapping fields. 
o Width – Specify the width to be used for each field and is used with the Fixed Width option. 
o Alignment – Data can be aligned to the Left or Right when using the Fixed Width option. 

 
Note:  Creating unique files is only recommended for use when using the Timed Interval Scan Mode. If 
used in any other mode, you may end up with a large number of unique files. 

 

7.1.5  Custom Endpoint 

Choosing Custom Endpoint (previously Template) allows you to stream data to a number of different 
destinations. These currently include SMTP Email servers, HTTP servers, and Keyboard Emulation (HID). When 
the Custom Endpoint destination is selected, the following parameters can be set. 
 

• Report – This is the template file that defines the layout of the data that will be sent to the Endpoint. 
This file is an XML document that describes the layout of the generated template. The configuration 
options for this are described in Appendix D. 

• Sender – The Sender field is used to select where the generated template file will be sent when tags are 
read. The Sender currently includes sending the template to an SMTP or HTTP Server. To add senders to 
this list, click on the Endpoints button and follow the steps in Section 7.1.5.1 below. 

7.1.5.1  Endpoints 
An Endpoint is a location in which the generated template can be sent. These include HTTP web servers or 
an SMTP mail server. The Configurations are detailed below. 
 
SMTP Server 
After selecting an SMTP Server as an Endpoint, the generated template will be sent in an Email to the 
configured SMTP Server. The settings for the SMTP server depend on the settings required for the SMTP 
Server being used. 
 
• Host – The Host or Address of the SMTP Server. 
• Port – The listening port of the SMTP Server. 
• Username – The username for a valid account of the SMTP Server. 
• Password – The password of the user. 
• Sender – The Email account from which the Email will be sent from. 
• Recipients – A comma separated list of Email addresses the email will be sent to. 
• Subject – The Subject of the Email. 
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URL 
The URL Endpoint option will make a web request to a URL when the template is generated and sent to 
the Endpoint. This allows a user to send web service requests to a server in a customized format such as 
JSON using standard web verbs such as GET, POST, PUT, etc. 
 
• URL – The web server to use in the request. 
• Method – The web server verb to use in the request. This allows REST type requests to be made 

with the generated template. 
• Content-Type – The content type HTTP header sent in the request. 
• Headers – Use the Headers grid to specify custom HTTP headers to be sent in the request. Use the + 

button to add a head and set the Name and Value. Press the X button to remove the select HTTP 
header. 

• Username – If required, the username of the web server. 
• Password – If required, the password of the web server username from above. 
• Logged in user – when enabled, this uses the current logged in Windows user to access the web 

server. This can be used when connecting to a Microsoft IIS web server that requires Active 
Directory credentials. 

 
Keyboard Emulation (HID) 
The Keyboard Emulation endpoint will send the generated template as Keyboard Input to any window 
that currently has focus. For example, an RFID tag read can be sent to Microsoft Notepad if notepad 
currently has focus. 
 

7.1.6  PTS RTLS Cloud 

The PTS RTLS Cloud destination is used to send ClearStream processed real-time location service (RTLS) data to 
the PTS RTLS Cloud (subscription and internet connection required). This service allows a user to upload maps 
and floorplans, position RTLS devices, and create zones to map and locate tagged assets in real-time. To 
configure the PTS RTLS Cloud select it as the destination, then make sure the Field Mappings are configured as 
needed. The username and password for the PTS RTLS Cloud will also need to be set on the Tools-
>Registration/Subscription dialog.  
 
7.2 Field Mapping 

Once your data Destination has been defined, you will then be able to associate the fields or columns in your 
selected Destination to the fields available from the RFID/Bluetooth Source. You are also presented with a 
toolbar which is explained below. 
 

• Add Field – This adds an additional field to the mapping for both the Source and Destination. 
• Remove Field – If a particular field is selected, it removes this from the mapping and shift all fields up. 

To remove an entire row, select the row from the left-hand column. 
• Move Up/Down – If a particular field is selected, it moves this field up or down in order. To move the 

entire row, select the row from the left-hand column. 
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• Reset Mappings – This resets the field mappings to the default state. 
• Clear Mappings – This removes all field mappings.  

 
7.3 Advanced Field Mapping Options 

Clicking the Advanced checkbox in the field mappings area exposes some additional settings. If you have the 
UpdateExisting or UpdateExistingAppendIfNotFound option set (See Section 7.4 below), you can choose what 
happens with data when it is synced from the Source to the Destination. The options are described below. 
 

• Overwrite – This is the default behavior. If the “Advanced” checkbox is not selected, all source fields will 
overwrite their respective destination fields. Please note that these field mapping options are retained 
even if the advanced checkbox is un-enabled. 

• Sum – This option adds the source field data value to the destination field data during a sync. This 
option only works with numeric values. This can be used to determine the number of times a tag has 
been read. 

• Subtract – This option subtracts the source field data value from the destination field data value during 
a sync. This option only works with numeric values. 

• Do Nothing – This option does nothing to the field during a sync. 
• Do Nothing when Null – This option does nothing to the field during a sync if the source is blank (null). 

 
7.4  Setting Update Options 

The Update Options allow you to control how the data is posted to your destination. The options available are 
Append, Overwrite, UpdateExisting, UpdateExistingAppendIfNotFound or Delete Existing and are explained 
below.  
 

• Append – This takes the streamed data and adds it to the existing data in your Destination. 
• Overwrite – This takes the streamed data and overwrites any existing data in your Destination. 
• UpdateExisting – This takes streamed data and updates rows in your Destination based on the Update 

Fields chosen. This does not add any new data if a row is not found. 
• UpdateExistingAppendIfNotFound – This takes streamed data and updates rows in your Destination 

based on the Update Fields chosen. This will also add any data rows not found in the Destination. 
• Delete Existing – This takes streamed data and deletes rows in your Destination based on the Update 

Fields chosen. Data that does not match is ignored. 
 
Note: When selecting one of the two UpdateExisting options you will need to specify fields in which to 
update the row based on. In most cases, this field will be set to the Tag ID field of your Destination. 
Fields can be added and removed by using the Add and Remove buttons. 

 
Note 2: When selecting Overwrite, you have the ability to add Destination Filtering. If used, you can 
specify a filter definition to use when deciding which rows in your destination to be overwritten. Rows 
that match this filter will be overwritten. If a filter is not specified, then all rows in the Destination will 
be overwritten. 
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7.5 Adding Source Filters 

Located in the Options tab of the Source settings, adding a Source Filter allows you to control which data is 
streamed to the Destination. A typical use for this is allowing only tags read by antenna 1 to stream data to the 
Destination. To setup Source Filtering follow the steps below. 
 

1. Click the Add button to create a new filter. 
2. Select a field to filter on from the Field drop down. 
3. Select a Comparison Type: 

a. Equals (=) – Data is only streamed when it matches the entered Value. 
b. Not Equal (<>) – Data is only streamed when it does not match the entered Value. 
c. LIKE – Data is only streamed when it is similar to the entered Value. 
d. NOT LIKE – Data is only streamed when it is NOT similar to the entered Value. 
e. Greater Than (>) – Data is only streamed when it is greater than the entered Value. 
f. Greater Than or Equal to (>=) – Data is only streamed when it is greater than or equal to the 

entered Value. 
g. Less Than (<) – Data is only streamed when it is less than the entered Value. 
h. Less Than or Equal to (<=) – Data is only streamed when it is less than or equal to the entered 

Value. 
4. Enter a Value that you want the filter to match. 
5. To remove a filter, highlight it and click the Remove button. 

 
Example: Setting a filter where “Antenna = 1” will only stream data captured by the antenna connected 
to port 1 on your RFID reader.



Chapter 8: Application Preferences  

ClearStream RFID  Developed by Portable Technology Solutions 42 
 

Chapter 8: Application Preferences 
 
These Preferences allow you to set the default project path, choose the sync server port and set the level of 
logging. This area is also used in configuring the ClearStream RFID Service explained further in Chapter 9. 
 
8.1 Server Settings 

Located in the Tools menu under Preferences, the following options can be set under the ClearStream RFID 
Management Studio Settings section: 
 
8.1.1  General Settings 

ClearStream RFID Management Studio Settings 
 

• Default ClearStream Project Location – Set this to the location you would like your projects to save. 
• Sync Server Port – The port number ClearStream RFID will listen for Web Service API requests. (Default 

setting is 4405) 
• Sync Server Logging Level – Sets the level of detail written to the ClearStream RFID log file. More 

information on logging can be found in Section 8.2 below. 
• Minimize to System Tray – When enabled, the application will hide the task bar shortcut and show an 

icon in the System Tray. From the system tray the device can be started and stopped. 
• Start Minimized – When enabled, the application’s window will start in the minimized state. 

 
ClearStream RFID Sync Service 
See Section 9.1 below for more information on setting up the Windows Service with ClearStream. 
 

8.1.2  Notifications 

You can add notifications via email for events such as reader connectivity loss, critical errors and when a reader 
starts/stops. To add a new notification, click the Plus (+) button and configure the below settings. Click the 
Minus (-) button to remove an existing notification. 
 

• SMTP Host – Set your email account’s host address. 
• SMTP Port – Set your email account’s port number. 
• Username – Set your email account’s username. 
• Password – Set your email account’s password. 
• Require SSL – Enable if your email account requires SSL. 
• Sender – Set to an email address you would like the notification to come from. This account must have 

Send As permission. 
• Recipient(s) – Set to who should receive this notification email. For multiple emails separate with a 

semi-colon (;). 
• Subject – The email subject of the notification email. 
• Notifications to send – The types of notifications to be sent. Each type will send a separate email. 

o Critical Error – A notification is sent whenever there is a critical error during the read process. 
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o Reader Connection Lost – A notifications is sent whenever ClearStream loses connectivity with a 
reader. 

o Reader Connection Reestablished – A notifications is sent whenever ClearStream reestablishes 
connectivity with a reader after a connection loss. 

o Reader(s) Started – A notification is sent whenever a reader is Started. 
o Reader(s) Stopped – A notification is sent whenever a reader is Stopped. 

 
8.1.3  Accept command messages  

Enabled by default, this allows ClearStream RFID to accept external command messages such as the Start/Stop 
of a reader through the ClearStream Web API. 
 
Cross-Origin Resource Sharing (CORS) 
Cross-Origin Resource Sharing (CORS) is a mechanism that uses additional HTTP headers to tell a browser that a 
web application has permission to access resources from a different origin. The different origin in this case is the 
ClearStream Web Service. This value should be set to a web server that is going to make requests to the 
ClearStream Web Service API. If this is not set, a browser will block the request and write an exception to the 
console similar to the following: Cross-Origin Read Blocking (CORB) blocked cross-origin response /device with 
MIME type application/json. See https://www.chromestatus.com/feature/5629709824032768 for more 
details. 
 
 
8.2  Event Log 

The Event Log provides users with different levels of information that can be used in troubleshooting 
connectivity or data streaming issues. To open the log window, select Event Log... from the View menu. You are 
presented with the following options: 
 

• Logging Level – Choose from the options below: 
o None – No information will be logged. 
o CriticalError – Errors relating to significant data stream problems or connection loss are logged. 
o Error – Both significant and smaller errors are logged. 
o Warning – Additional information regarding network issues are logged. 
o Info – The default level of logging, all primary connection and streaming events are logged. 
o Verbose – All actions taken by ClearStream RFID are logged in full detail. 

• Clear – Will clear the contents of the Event Log window. 
• Open log file – Allows you to open the stored log file and view all activity. This file can also be found 

here: C:\ProgramData\PTS\ClearStream RFID\SystemInfo\System 
• Always on top – When checked, the Event Log window will remain on top of all other open windows. 
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Chapter 9: Running as a Windows Service 
 
ClearStream RFID can be run as a windows service allowing data streams to take place unattended. This is useful 
when installing to environments that require minimal user interaction and does not require the ClearStream 
RFID software to be open. 
 
9.1 Connecting to your Project 

In order to use the ClearStream RFID Service, you must first associate a project for use with the service and set 
your desired port. This is done by following the instructions below. 
 

1. Select Preferences from the Tools menu. 
2. In the ClearStream RFID Sync Service section, click the Folder icon in the Active ClearStream Project 

(.tcproj) field; select your desired project and then click Open. Alternatively, you can click the Use 
Current Project button to associate the currently opened project to the Windows Service. 

3. Set the desired Sync Service Port. Typically, this is left at the default of 4406. 
4. Choose the Sync Service Logging Level to use for the service. 
5. Select OK to save the settings. 
6. Proceed to Section 9.2 below to learn how to Start and Stop the service. 

 
Note: When making changes to the project used for the service, it is recommended you Stop the service 
if it is currently running.  

 
9.2 Start/Stop the Service 

To start the Windows Service, use one of the options below. 
 

• Using the Start/Stop Service options under StartAll ProgramsPTSClearStream RFID. 
• Using the Services console from within Windows and right clicking the ClearStream RFID Service. 
• Right clicking the ClearStream RFID system tray icon when enabled. (This is enabled by double-clicking 

the clearstream_tm.exe icon located in the ClearStream RFID install directory.) 
 
When the ClearStream RFID Service is started, the streaming of tags can be started in three ways.  
 

• If the Auto Start Readers On Start option within the Application Preferences dialog is enabled, all 
readers are automatically started when the Windows Service starts.  

• Right click on the ClearStream RFID Tray Monitor and select ReadersStart All. 
• Use the ClearStream API via any web enabled device.  

 
Note: If the ClearStream RFID Service is set to Automatic or Automatic (Delayed Start), the service will 
start automatically when Windows starts. If you do not want to start the service when Windows starts, 
simply set it to Manual. 
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Chapter 10: Virtual Site Survey 
 
The Virtual Site Survey tool offers the ability to set up a virtual RFID environment. A basic floor plan can be laid 
out using this tool along with tagged items, fixed readers and antennas. The environment can be animated to 
show the movement of items throughout the virtual environment and how these items can be scanned using 
the virtual fixed RFID readers. Factors that can affect read performance are also taken into consideration; 
including distance from antenna, tag type, and tagged item material type. 
 
10.1 Designing and Building the Virtual Environment 

To configure a virtual environment, select ToolsVirtual Site Survey from the menu. 
 
Building the Floor Plan 
 

1. Use the Add Floor Space button to build out the floor plan of the environment. 
2. To remove existing floor space, use the Remove Floor Space button. 

 
Adding tagged items 
 

1. Click the Tag Container button to add tagged items to the environment. 
2. Click within the created floor space to add items. 
3. Use the property grid on the right-hand side to change tag properties including Type, Material, 

TagType, TagCount, TagList, Size and Animation Cycle. 
 
Adding readers 
 

1. Click the Reader button to add fixed readers to the environment. 
2. Click within the created floor space to add readers. 
3. Use the property grid on the right-hand side to change reader properties. 

 
Adding Reader Antennas 
 

1. Right click on a Fixed RFID Reader already added to the environment and select Add Antenna. 
2. Add the required number of antennas to the RFID reader. 
3. Aim the antennas to the desired location using the antennas target icon. 

 
Adding GPO Device (LightStack) 
 

1. Right click on a Fixed RFID Reader already added to the environment and select Add GPO Device. 
2. Click the newly added GPO device and then select a Type from the Selected Object’s Properties. 

Choices are LightStack_Onelight, LightStack_TwoLight or LightStack_ThreeLight. 
3. Based on this selection, a number of ports will display below. Note the port numbers when setting 

up GPO in your Sync process. 
4. Position the light stack where desired. 
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Adding Text 
 

1. Click the Text button from the Toolbox. 
2. Click within the created floor space to add text. 
3. Use the property grid on the right-hand side to change the text. 

 
10.2 Reading Virtual Tags 

To begin reading tags in the virtual environment, the RFID readers need to be powered on. Follow the steps 
described in Chapter 5 to configure the reader and select where the virtual tag data is to be sent.  
 
Note:  Only readers configured as Emulated readers can be used with the Virtual Site Survey. 

 
1. Select the readers in your environment, making sure the IDs match the IDs of the configured readers 

in the Reader Configuration dialog. 
2. Use the Start/Stop form to power up the virtual readers. 
3. Drag tagged items into the field of view of the antennas. As the tags pass through these fields, they 

will trigger a read, and the tag information is sent to the selected destination. 
 
10.3 Configuring an Animation 

The Virtual Site Survey Animation feature allows for an automated test of the tagged items moving within the 
virtual environment. Tagged items within the field of view of an active antenna will be read by that antenna and 
transferred to the data destination. 
 
To configure an Animation. 
 

1. Add Animation Areas to the environment using the Area Toolbox item. Animation areas are added 
sequentially to the environment. All items follow the path created by the Animation Areas during 
the animation process. 

2. Select the desired animation type using the Animation drop down at the top right of the Virtual Site 
Survey window. 

- CradleGrave – All items start at Animation Area 1 and move to the final Animation Area. 
When tagged items reach the final Animation Area, they are removed from the animation. 

- Cycle – All Items start at Animation Area 1 and move to the final Animation Area. When 
tagged items reach the final Animation Area they continue on to the first Animation Area 
and the animation continues indefinitely. 

3. Use the Play button to start the animation. 
4. Use the Stop button to stop the animation. 
5. Use the Speed text box to change the speed of the animation. 
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Chapter 11: Web Service API 
 
The Web Service API allows an outside application or web page to control the configured devices and interact 
with the tags and beacons in its field of view. It exposes a simple to use REST interface that can be implemented 
in any programming language capable of working with Web. This API replaces the legacy ClearStream .NET API in 
older versions. 
 
The web service API exposes the following operations: 
 

• Start and Stop RFID/BLE readers and gateways 
• Start and Stop GPOs on devices that support GPOs 
• Get, Update, Clear, and Post the buffer of a Reader or Gateway 

 
Service URL: http://(IP Address of ClearStream Server):4406/api/v1 
 
Web Service Port 
The default port used by the web service is 4405 when using the Management Studio, and 4406 when using the 
ClearStream Windows Service. This can be changed using Tools->Preferences described in Chapter 8. 
 
11.1  Requests 

The ClearStream Web API is based on REST principles: data resources are accessed via standard HTTP requests 
to an API endpoint. Note that in most cases a single device can be specified by placing the device index after the 
/device/ portion of the service’s URL. When this is omitted all of the devices will be configured. Alternatively, the 
device index can be specified in many of the JSON properties. 
 
11.2  Responses 

All responses are returned as JSON objects to the requestor. 
 
Example 

HTTP/1.1 200 OK 

Content-Type: application/json; charset=utf-8 

{ 

    "result":”true" 

} 

 

Example 2 

HTTP/1.1 200 OK 

Content-Type:application/json; charset=utf-8 

{ 

    "devices":[{ 

        "name":"MRU",  

        "deviceid":"5656572",  

        "started":true,  

        "inventory":true, 

        "bufferactive":false, 

        "buffer":[{ 
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            "EPC":"000000000000000000001784", 

            "TID":"", 

            "UserMemoryBank":"", 

            "Antenna":"Antenna: 4", 

            "PeakRSSI":"0", 

            "DateTime":"8/20/2018 10:56:20 AM", 

            "ReaderName":"MRU", 

            "StartEvent":"Management Studio Start/Stop Form", 

            "Count":"1", 

            "TagEvent":"", 

            "Direction":"Direction not enabled."}, 

           {"EPC":"000000000000000000001783", 

            "TID":"", 

            "UserMemoryBank":"", 

            "Antenna":"Antenna: 4", 

            "PeakRSSI":"0", 

            "DateTime":"8/20/2018 10:56:21 AM", 

            "ReaderName":"MRU", 

            "StartEvent":"Management Studio Start/Stop Form", 

            "Count":"1", 

            "TagEvent":"", 

            "Direction":"Direction not enabled."], 

            "gpos":[] 

        } 

    ] 

} 

 
 
11.3  Error Responses 

When an error occurs the following HTTP error codes will be returned: the body will contain a JSON response 
with the error code and a message describing the issue in more detail. If an error code of 500 is returned, the 
ClearStream event log will contain additional information on the error. 
 

• 200 Success: The request has succeeded. The response body will contain the result. 
• 400 Bad Request: The request failed due to invalid syntax, missing parameters, or malformed requests. 

The message body will contain more information. 
• 404 Invalid Address: The requested resource was not found on the server. 
• 500 Internal Server Error: Check the event log for additional information. 

 
Example 1: 

 

{ 

    "result":false, 

    "code":404, 

    "message":"Invalid address" 

} 

 

Example 2: 

 

{"devices":[{ 
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    "deviceindex":"1",  

    "result":false, 

    "gpos":[{ 

        "port":1,  

        "result":false,  

        "message":"Requested port is not configured for this reader." 

     }] 

   }] 

} 

 

 
11.4  Operations 

/device 
 

Method: GET 
Used to get the full device status and data buffer. If no device index is specified the status of all devices will 
be returned. 
 

Example: 

 

Request  

    URL: /device/0 

    METHOD: GET 

 

Response 

      {"devices":[{ 

             "name":"Loading Dock A",  

             "deviceid":"12:3A:12:06:BE", 

             "started":true, 

             "inventory":true, 

             "bufferactive":true, 

              

             "buffer":[ 

                    {"EPC":"0015126387354843","ReaderName":" Loading Dock A "}, /* Row 1 */ 

                    {" EPC ":"0022106387354843"," ReaderName ":" Loading Dock A "}  /* Row 2 */ 

                   ], 

                    

             "gpos":[ 

                    {"port":0, "on": false},    /* GPO 1 - off */ 

                    {"port":1, "on": true}      /* GPO 2 - on */ 

                ] 

            } 

         ] 

      } 

 
Method: POST 
Used to change the status of the device. This includes device enabled state, and GPO state. 
 

Example: 

 

Request  
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    URL: /device 

    Method: POST 

    Body: {"devices": [{"start": true, "index": 0},{"start": true, "index": 1}]} 

 

Response 

 

{"devices":[ 

    {"deviceindex":"0", "result":true}, 

    {"deviceindex":"1", "result":true} 

]} 

 
/device/status 
 

Method: GET 
Used to get the current status of a device without the tag buffer data. If no device index is specified the 
status of all devices will be returned. 
 

Example: 

 

Request  

    URL: /device/2/status 

    METHOD: GET 

 

Response 

 

      {"devices":[{ 

             "name":"Loading Dock B",  

             "deviceid":"12:3A:12:06:BE", 

             "started":true, 

             "inventory":true, 

             "bufferactive":true,                 

             "gpos":[ 

                    {"port":0, "on": false},    /* GPO 1 - off */ 

                    {"port":1, "on": true}      /* GPO 2 - on */ 

                ] 

            } 

         ] 

      } 

 
/device/{deviceindex}/buffer 
Used to get or delete the current device buffer. A device index is required in the resource request. 
 

Method: GET 
Returns the current device buffer for the requested device index. 
 

Example: 

 

Request  

    URL: /device/0/buffer 

    METHOD: GET 
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Response 

 

{ 

    "buffer":[ 

        {"EPC":"0015126387354843", "ReaderName":"Loading Dock A"},   /* Row 1 */ 

        {"EPC ":"0022106387354843", "ReaderName ":"Loading Dock A"}  /* Row 2 */ 

    ]   

} 

 
Method: DELETE 
Clears the device buffer of the requested device index. 
 

Example: 

 

Request 

    URL: /device/3/buffer 

    Method: DELETE 

 

Response 

    {"result":true,"code”:200,"message":"Success"} 

 
/device/{deviceindex}/gpo 
Used to get or set the current GPO state. A device index is required in the resource request. 
 

Method: GET 
Gets the current state of the GPOs for the requested device. 
 

Example: 

 

Request  

    URL: /device/0/gpo 

    METHOD: GET 

 

Response 

 

{ 

    "gpos":[ 

        {"port":0, "on": false}, /* GPO 1 - off */ 

        {"port":1, "on": true}   /* GPO 2 - on */ 

    ] 

} 

 
Method: POST 
Sets the state of the GPOs for the requested device to On or Off. 
 

Example 

 

Request 

    URL: /device/2/gpo 

    Method: POST 

    Body: {"devices":[{"index":"2","gpos":[{"port": 1, "on":true}]}]} 
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Response 

    {gpos":[{"port":1, "result": true}]"} 

 
/version 
Used to retrieve the current version information of the ClearStream server. 
 

Method: GET 
Requests the version information from the server. 
 

Example: 

 

Request  

    URL: /version 

    METHOD: GET 

 

Response 

 

{"version":"4.1.0.442",”api_version”:”1.0”} 

 
/device/{deviceindex}/buffer/active 
Used to change the state of the device’s buffer to active or inactive. When set to inactive the buffer will not be 
changed by anything. The body of the request should contain the requested state. A device index is required in 
the resource request. 
 

Method: POST 
Used to change the device’s buffer state to active or inactive. 
 

Example: 

 

Request  

    URL: /device/0/buffer/pause 

    Method: POST 

    Body: {"isactive":false} 

 

Response 

 

{"result":true} 

 

 
/device/buffer/row 
Used to Insert or Update rows in the device’s buffer. The rows to be added are sent in the body and is made up 
of an array called buffer. This array contains the rows to be added to the devices buffer. To update a row in the 
buffer, the device’s key field value must match what is supplied in the body. For UHF/HF readers this is the EPC 
field, and for BLE Gateways this is the UID field. A device index is required for this method, if none is supplied 
the request will fail. 
 

Method: POST 
 

Example: 
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Request  

    URL: /device/1/buffer/flush 

    Method: PUT 

    Body: {"buffer":[{ 

               "epc":"400000000000000000001782",  

               "SalesOrder":"1000096778"}] 

          } 

 

Response 

 

{ 

    "results":[{ 

        "deviceindex":"1",  

        "epc":"hh0000000000000000001782", 

        "SalesOrder":"1000096778",  

        "result":true 

    }] 

} 

 
/device/buffer/flush 
Used to push the current buffer to the configured destination. This can also accept a filter in the request body to 
push only matching rows. This filter is an array called filters which must specify the device, a matching column 
name (from the buffer), and a value. If no device index is supplied all device’s buffers will be flushed. 
 

Method: PUT 
Used to flush the buffer 
 

Example: 

 

Request  

    URL: /device/1/buffer/flush 

    Method: PUT 

    Body: {"filters":[{"SalesOrder":"1994553"}]} 

 

Response 

 

{"results":[{"deviceindex":1, "result":true}]} 

 

 
/device/{deviceindex/name/deviceid/deviceuuid}properties 
Used to Select, Insert, Update or Delete custom device name value properties. These properties can be used in 
different ways for each device. They can be used to set Custom Field values, or to set Custom Tag event values. 
 

Method: GET 
Gets the current list of custom properties from the device. 

 
Example: 

 

Request  

    URL: /device/1/properties 
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    Method: GET 

 

Response 

 

[{"custom_property": "value of custom property"}] 

 
Method: POST/PUT 
Adds a custom property to the device, updates an existing property if it already exists. 

 
Example: 

 

Request  

    URL: /device/1/properties 

    Method: POST 

    Body: [{"custom_property":"value of custom property"}] 

 

Response 

 

{"result":true, "message": "Success."} 

 
Method: DELETE 
Removes a custom property by name from the device.  

 
Example: 

 

Request  

    URL: /device/1/properties 

    Method: DELETE 

    Body: ["custom_property"] 

 

Response 

 

{"result":true, "message": "Success."} 
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Appendix A: Moving ClearStream RFID to a New Host PC 
 
When using a subscription license of ClearStream RFID the client list can be moved to a new installation by 
simply entering your subscription login credentials on the ToolsRegistration/Subscription dialog. The device 
list will be automatically pulled from the subscription account. 
 
A ClearStream RFID perpetual license allows you to export your list of registered/un-registered seats making it 
easy to move the installation to a new PC. This is only required for a Perpetual Registration. If you have a 
Subscription, enter an account admin Username and Password on the ToolsRegistration/Subscription… 
dialog. All of the existing devices will be automatically downloaded. 
 
To Export the license file from ClearStream RFID (Perpetual Licenses Only): 

 
1. Launch ClearStream RFID. 
2. Select Registration/Subscription from the Tools menu and select the Import/Export tab. 
3. Click the Export button.   
4. Select a location and filename for the Export file and click Save. 

 
Note: A registration file can only be exported from a fully licensed install of ClearStream RFID. 

 
To Import the license file to your ClearStream RFID installation (Perpetual Licenses Only): 

 
1. Launch ClearStream RFID. 
2. Select Registration/Subscription from the Tools menu and select the Import/Export tab. 
3. Click the Import button and locate the previously created Export file. 
4. Select the file and click Open. 
5. You will receive confirmation of a successful import. 
6. The Registration tab should now be updated with the correct information. 

 
Note: A registration file can only be imported to a fully licensed install of ClearStream RFID. 
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Appendix B: Terms and Concepts 
 
Terms and Phrases 
 
As with most technologies, RFID and ClearStream RFID use industry accepted terms and phrases as well as 
terms that are unique to ClearStream RFID. 
 
RFID Reader: A transmitter/receiver that reads the contents of RFID tags in the vicinity. 
 
Bluetooth Low Energy (BLE): A wireless personal area network, designed to use very low power with a long 
transmission range. 
 
Beacon Gateway: A device used to collect Beacon pings and transmit them to a user defined location. 
 
Read Range: The distance in which an RFID reader and antenna can read an RFID tag reliably.  
 
Passive RFID Tag: An RFID Tag that does not contain a battery; the power is supplied by the reader. When radio 
waves from the reader are encountered by a passive RFID tag, the coiled antenna within the tag forms a 
magnetic field. The tag draws power from it, energizing the circuits in the tag. The tag then sends the 
information encoded in the tag's memory.  
 
Active RFID Tag: An RFID Tag equipped with a battery that can be used as a partial or complete source of power 
for the tag's circuitry and antenna. Some active tags contain replaceable batteries for years of use; others are 
sealed units. 
  
RFID Tag Inlay: Comprises the chip and aluminum, copper or silver antenna bonded to a polyethylene 
terephthalate (PET) layer that is delivered to the label maker "dry" (without adhesive) or "wet" (attached to a 
pressure sensitive liner). The inlay is adhered to the back side of the label and printed and encoded by an RFID 
printer. 
 
Bluetooth Beacon: A battery powered Bluetooth Low Energy transmitter. 
 
LLRP: The acronym of 'Low Level Reader Protocol', ratified by EPCGlobal in April 2007. LLRP is the RFID-aware 
protocol that is intended to standardize the network interface of the RFID readers. It is designed as a standard in 
order for developers to have a common programmatic interface to RFID readers from different manufacturers. 
 
Stream: The ability of ClearStream RFID to constantly send data from RFID readers to a predefined destination.   
 

Profile: A Profile is simply a term used to describe the collection of individual processes. This Profile also 
determines the order in which a Process is run.  

Process: A Process is the most basic level of configurations for ClearStream RFID and represents the 
transfer/streaming of data. These processes are configured to send data in one direction; from a Source to a 
Destination.  

http://www.pcmag.com/encyclopedia_term/0,2542,t=RFID+inlay&i=56950,00.asp
http://en.wikipedia.org/wiki/EPCGlobal
http://en.wikipedia.org/wiki/RFID
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Source: The Source is the collection of information used to update the destination in a given streaming Process.  
In ClearStream RFID, the source is set to the RFID reader(s) being used in a Process. 
 
Destination: The Destination is simply the endpoint or database designated to receive streaming data from the 
reader(s).  The Destination is determined by the type of file you wish to send data to. 

ClearStream RFID Project: A ClearStream RFID Project is a collection of profiles and processes.  

ClearStream RFID Project Export: This file encompasses all the settings within a ClearStream RFID project 
allowing for easy sharing but requires the file to be imported back into ClearStream RFID rather than simply 
opened. 

Primary ClearStream RFID File Extensions: 

ClearStream RFID Project file - .tcproj 
The file used by ClearStream RFID to save projects. This file requires associated files in sub folders that 
contain configuration information. These files and folders are created whenever a new Project is saved. 
 
ClearStream RFID Profile Export file - .tce 
This file is a sharable version of the .tcproj file. This manually created exported file contains all the info 
normally stored in the .tcproj file along with the associated folders. Once shared and imported back 
into ClearStream RFID, this file would be saved as a .tcproj for editing or use. 
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Appendix C: Creating a Windows Data Source 
 
Creating a New Data Source to Connect to an Existing ODBC Database 
 

1. Click the Windows Start Menu at the lower left corner of your PC. 
2. Navigate to and open the Control Panel window. 
3. If your Control Panel is set to Icon View, then double click the Administrative Tools Icon. 
4. If your Control Panel is set to Category View, first Select System and Security, then double click the 

Administrative Tools icon. 

5. Double click the Data Sources (ODBC) icon. 
6. The ODBC Data Source Administrator window will open. 

 

 
 
7. Select the System DSN tab, then click the Add button. 
8. The Create a New Data Source window will open. 
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9. Select the appropriate driver based on the database type you wish to use. If the desired driver is not 
present, consult your database user guide on how to manually install the proper driver.  

10. Click Finish 
11. This will open the database Configuration window. Enter the relevant information about your DSN and 

select the database file. The method for selecting the database will vary based on which type you are 
using. Refer to the built-in Windows Help or your database user guide for additional information. 

12. After completing the configuration, Click OK to close the ODBC Data Source Administrator control 
panel. 

13. The database is now configured and will appear in the OBDC Datasource dropdown in ClearStream 
RFID. If the database name is not visible, click the Refresh Button  to update the dropdown list.  
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Appendix D: ClearStream Report Sample 
 
Sample format using advanced features 
The following is a sample report that will generate a template that is sent to an Endpoint.  
 
<format> 
<definevars>    
        <var  name ="epc"              type="DB"   source="EPC"/> 
        <var  name ="datetime"             type="DB"   source="DateTime"/> 
        <var  name ="device"             type="DB"   source="Device"/> 
        <var  name ="antenna"               type="DB"   source="Antenna"/> 
        <var  name ="tagevent"             type="DB"   source="TagEvent"/> 
</definevars> 
<printerdata> 
 <formatheader max_records_per_page="1"> 
 </formatheader> 
<pageheader> 
<br/> 
RFID Tags Read<br/> 
Date: <var name="datetime"/><asc>0D</asc> 
Location: <var name="device"/><asc>0D</asc> 
<br/> 
Inspection Items:<br/> 
</pageheader> 
<record> 
Tag: <var name="epc"/><asc>0D</asc> 
Read on antenna: <var name="antenna"/><asc>0D</asc> 
Event: <var name="tagevent"/><asc>0D</asc> 
</record> 
<pagefooter> 
<br/> 
<asc>0C</asc> 
</pagefooter> 
<formatfooter> 
</formatfooter> 
</printerdata> 
</format> 
 
<definevars> 

This section of a report defines the variable data for a report. These definitions allow you to define variables that 
are assigned to specific fields within the ClearStream field mappings. In this example, we have defined the 
following variables: 
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EPC, DateTime, Device, Antenna and Tag Event 

Each variable definition contains information about the datatype along with the ClearStream field to be used in 
the template. These fields will be loaded into the ClearStream Field Mappings area when the report is selected. 
At the time of generating the Template the fields in this section will be populated with the data being sent from 
the Source. 

<formatheader> 

Every report contains a format header which typically contains additional elements relative to the overall report. 
In the example above, the only setting required in this area is the number of records to include in this report. 
Since this report is only emailing data on one specific tag at a time, this value should be “1” as shown. 

<pageheader> 

Every report also contains a page header section which allows you to define elements that appear on every 
page. In the example above, since there is only one page, this contains simple header type information for the 
body of the generated template. The title of this sample template is “RFID Tags Read”. Also included in this 
header are the date/time, and location of this particular tag read. It is worth noting that both of these values are 
referencing data from ClearStream via the respective variable definitions. 

<record> 

The record section of a report allows you to define the section(s) of the report that will send for every record 
included in this template. In the example above, this will only represent one record since we are only creating 
one template from a single record. 

<pagefooter> 

The pagefooter allows any summary type data to be generated in the template. 
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Appendix E: Custom Devices with ClearStream RFID 
This section describes how to add devices to ClearStream that utilize the Custom device type. Devices that can 
be configured to send data to custom end points can utilize this device type to stream data to a user selected 
destination in the same way that core RFID, and BLE devices can stream data. The support end point 
communication options are HTTP, TCP, and UDP, and the data must be structured as a JSON array of name value 
pairs, that match the Source devices field names. The configuration of some supported devices are described 
below. 
 
E.1 Cognex Barcode Scanner 

Barcode scanners developed by Cognex can be configured to send data to ClearStream, and then ClearStream 
will stream the barcode data to the user selected destination. To configure a Cognex barcode scanner follow the 
steps below. 
 

• Install the Cognex DataMan Setup Utility. 
• Open the setup utility and allow it to find your Cognex barcode reader. 
• Double click on the barcode reader to configure it (take note of the serial number at this step). 
• Navigate to the Communication category within the setup utility. 
• Set the Destination to ‘Ethernet/IP’, set the Type to TCP, and set the IP address to the IP address where 

ClearStream is running. If required, you can also set the port that ClearStream should be listening on to 
receive the barcode TCP data (make sure this port is open on the PC running ClearStream). 

 
Note: To set the destination IP/Port, you need to disable the option in order for you to be able to 
change the settings, and then you need to re-enable the setting once done. 

 
• Navigate to the Data Formatting category of the setup utility and select the Custom Script section. Enter 

the script as below: 
 

function onResult (decodeResults, readerProperties, output){ 

    var mac = dmccGet('DEVICE.MAC-ADDRESS').response 

    var serial = dmccGet('DEVICE.SERIAL-NUMBER').response; 

 

    if (decodeResults[0].decoded){ 

        output.content = '[{"MAC":"'+ mac+'","DeviceID":"'+serial+'","barcode":"'+ decodeResults[0].content +'"}]’; 

    } 

} 

 
• Save your settings and allow the device to reboot. 

 
At this point the barcode scanner is configured to send all barcode data to the IP address specified. ClearStream 
will now need to be configured to listen for this data, and map it to a destination following the steps below: 
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• Install/Open ClearStream RFID. 
• Create a new project and add a Profile/Process. 
• From the source side of the configuration screen click on the Devices button. 
• Add a new Device to the configuration of type Cognex. 
• Set the Device ID to match the serial number that was noted in the earlier step. This is used to verify the 

scanned data from the barcode data, as well as indicate which reader the scanned data is being sent 
from. 

• Add a Custom Field called barcode to the Custom field list. You will note that this matched the JSON 
field from the custom script section. 

• On the Data Settings tab select the barcode field as the Key Field. 
• From the Device tab, set the Listener Type to TCP, and set the port to match what you selected during 

the barcode reader setup. 
• Configure a destination for the barcode device and map the columns as appropriate. Refer to Chapter 7: 

Data Integration Settings for information regarding the destination options. 
• Save the project. 

 
ClearStream can now be started by navigating to the form Start/Stop, and clicking the Start Selected on this 
device. Anytime a barcode is decoded by the Cognex reader, it will be sent to ClearStream and streamed to the 
selected destination. 
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